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CRICUT® COACH PLAYBOOK

ABOUT THIS PLAYBOOK

This Playbook gives you quick and easy visual steps for every popular task in
Cricut Design Space®. Just follow along with the steps and you’ll be good to go!

| update this Playbook whenever there are
major changes to Design Space, and all
Playbook purchasers get free updates. Each
time | do a major update of the Playbook, |
will send you an email notifying you of the
update along with a download link to get the
update free of charge. If you have suggestions
for new pages in this Playbook, please email
me at hello@jennifermaker.com.

If you’d like to print this Playbook for quick
reference, see page 109 for printing tips. You
can print at home, or you can take the file
to a print shop or office supply store—a print
release form is provided in the back of the
book for your convenience.

)

If you have any questions about using the Playbook,
email me at hello@jennifermaker.com.

For more Cricut ideas and inspiration, join me
at https://jennifermaker.com/cricutcrafters

Key to Playbook Pages:
Happy making,

JWWM/@UI/ Tips are in blue

Notes are in yellow

Warnings are in pink

ISBN: 978-1-64737-000-8 - version 5.4 - updated June 2021

Cricut® Coach Playbook is copyright 2018-2021 by JenniterMaker® LLC. All rights reserved. Cricut® and Cricut Design Space®
are registered trademarks of Provo Craft. Use of them does not imply any affiliation with or endorsement by them.
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HOW TO INSTALL
CRICUT DESIGN SPACE (MAC)

Cricut Design Space is the free software you’ll use to make amazing things on your Cricut. To install Cricut
Design Space on your Mac desktop or laptop computer, go to design.cricut.com and click the Download
button. Design Space for Desktop will allow you to work both online and offline. Follow the directions below
to install it on your Mac.

Step 1: Download the installer at Step 2: Open the downloaded Step 3: Open your Applications

design.cricut.com file and drag (click, hold, & move) folder and double-click
the Cricut icon over the folder, the Cricut application ’é

then let go of the mouse. to launch it.

& Finder Fle Edt Vv W Window Help

cricut.

Design Space®

Setup a new Cricut product, browse projects, start designing,
‘and more.

B8 151 0 the Grcut Trms o Use and Prvacy Pocy

Note: If you get this warning, you need to open Step 4: If prompted, sign in with your Cricut
System Preferences, click on Security, account email and password. (If you’re already

click General, and click “Open Anyway” @ signed in, you’re logged in automagically.)
at the bottom of the screen.

@& Cricut Design Space File Edit View | Help

Note: If this
is your first
e e R - . time using

App Store.

o R R s Design
apps from the App Store. Create Cricut ID
e sttt 1034t o SRR

click here
to create
a free

account.

& CricwtDesignSpace Flo Eat View Holp
—
ece

Clon smSpace

:3— JenniferMaker ,
cricut

v View Profile

Home

Canvas

New Machine Setup
Calibration

Manage Custom Materials
Update Firmware

Account Details

INSTALL DESIGN SPACE (MAC)
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HOW TO INSTALL
CRICUT DESIGN SPACE (PC)

Cricut Design Space is the free software you’ll use to make amazing things on your Cricut. To install Cricut
Design Space on your Windows desktop or laptop computer, go to https://design.cricut.com and click the
Download button. Design Space for Desktop will allow you to work both online and offline. Follow the
directions below to install it on your PC.

Step 1: Download the installer at Step 2: Open the downloaded Step 3: Once installed, Cricut
design.cricut.com file and wait for it to install Design Space will automatically
onto your hard drive. open and you’ll see this screen.

\

cricut. v Tt cricut. i

sign Space® for Windows® '“ \ ; \ a =

Staring Dasign Space

Step 4: If prompted, sign in with your Cricut
account email and password. (If you’re already a’r JenniferMaker
signed in, you’re logged in automagically.) > View Profll

Home

Note: If this
is your first
time USing New Machine Setup
Design

Space, flage Custom Materials
click here pdate Firmware

to create

a free

account.

Canvas

cricut

Account Details

. Once Cricut Design

cricut Space is installed 'é
on your PC, an icon

will appear on your
desktop as well as in your
taskbar. Just double-click the
icon to go to Cricut Design
Space again. If you cannot
find the icon for Cricut Design
Space, click the bottom-left
Start button on your desktop,
tap “All Apps” in the menu and
look for Cricut Design Space.

INSTALL DESIGN SPACE (PC)

delive
' Use and Privacy
jicy
CREATE CRICUT ID >

L4
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HOW TO OPEN AND
START A NEW PROJECT

Step 1: Open Cricut Design Space on your Desktop by double-clicking its icon in the dock/taskbar or type
design.cricut.com in your web browser to get a page with a button to open the desktop app.

OR @0 @ NewTab*

~ = (C % design.cricut.com

5 Apps B & Cricut Design Space
design.cricut.com

Step 2: If prompted, sign in with your email and Step 3: Click the New Project icon on the left
password. (If you’re already signed in, you will side or the New Project button in the upper
be taken to the next step automagically.) right corner (they do the same thing).

Cricut Design Space

cricutinfusible ink.
Cricut : Pro-level heat transfers

«AW/é ifeti >
LIAF Wlﬁ that last a lifetime.

##:LmF‘MW’ﬁ [ oo |

iCrIcut ' &/ﬂlpt /

I Love Cricut ... Smiley Face ... Heart Slice by...[¥] Script Text W... (7]

2 .ee <& . P oo P

\~ JenniferMaker

. View Profile

images, shapes, text, and projects!

You will get a new canvas, ready for you to add %

Home

Canvas

New Machine Setup

Calibration

Manage Custom Materials

Update Firmware

fe {® 3 iR = {0 o [

Account Details

Link Cartridges

Cricut Access

Settings

Legal

OPEN & START PROJECT
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HOW TO CONNECT A MAC
TO CRICUT VIA BLUETOOTH

Step 1: Open System Preferences in your Dock. Step 2: Click the Bluetooth icon to open it.

You can also find OO @ < | > J i System Preferevles Q search
System Preferences

by clicking on - : ﬁ @ -

General Desktop & Dock Mission g Security Spotlight  Notifications

the Apple menu Screen Saver Control off & Privacy

in the upper

left corner and N vy = . =

ChOOSlng System Displays Energy Keyboard r ma Printers &
Saver Scanners

Preferences.

» @ @ @

iCloud Internet App Store Network Extensions Sharing
Accounts

n 0 *» ©® ©

Users & Parental Date & Time Time Accessibility
Groups Controls Machine

16 1o 04 1 43 |2 15

Step 3: If Bluetooth is off, click Turn Bluetooth On. Step 4: Locate a device that starts with “Cricut”
and click Connect or Pair. If you do not see it
Bluetooth Q Search listed, make sure your Cricut is turned on and no
other Bluetooth device is connecting to it.

Devices

Jennifer's iPhone -
Not Connected Devices

JLab Neon BT
CricutAIR2-27E0 & Not Connected

Bluetocth: On l Jennifer's iPhone v
Turn Bluetooth Off Not Connected

ow discoverable a: .
e CricutAIR2-27E0
“27" iMac Retina” Bluetooth: On

Turn Bluetooth Off

JLab Neon BT : o
&, Not Connected Nl Bluetooth

Now discoverable as

- 27" iMac Retina”
|| Show Bluetooth in menu bar Advanced...  ?

Step 5: If you get a pairing request, type 0000
(that’s four zeros) as the passcode and click Pair.

|| Show Bluetooth in menu bar Advanced... 17

Bluetd Q Search

Devices

K ¥

CONNECT VIA BLUETOOTH

Bluetooth Q Search

Devices

‘ JLab Neon BT

Blueto( Not Connected

Turn Blue l Jennifer's iPhone
Ng d

Now discc | lgnore this device 3 -
aey J 24" CricutAIR2-27E0
2 MRy Connected
Bluetooth: On

Turn Bluetooth Off |
Once connected, you can select your machine Now discoverable as

from the drop-down menu in Cricut Design Space. 27" iMac Retina"

PAGE 7 ¥V COPYRIGHT JENNIFERMAKER®
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HOW TO CONNECT A PC
TO CRICUT VIA BLUETOOTH

Step 1: Open the Control Panel app. Step 2: Click on Add a Device under Hardware.

£ Control Panel
Find it by typing o Corvl et > vt
“ContFOI Panel” Adjust your cBmputer's settings View by:  Category
into the search bar b and secuity S
at the bottom of e iy O @ce
your win dow. Backuffand Restore (Windows 7)

Appearance and Personalization
> Clock and Region
(YW change date, time, or number formats

Ease of Access
Let Windows suggest settings

Optimize visual display

rk and Internet

Control Panel

Programs
Uninstall a program

Step 3: Let your computer look for your Cricut, Step 4: If you get a pairing request, type 0000
then click its icon and click Next. (that’s four zeros) as the passcode and click Next.

¥ Add a device uF Add a device

Choose a ghyice or printer to add to this PC Enter the passcfide for your device

Select a device

ight need to enter the same passcode into the device.
CricutAIR2-27EQ
Other

glering a passcode on it.

L ——

Mot finding what you're looking for?

CONNECT VIA BLUETOOTH

Step 5: Allow your PC time to setup the Bluetooth Once paired, it will appear in your Devices and
connection to your Cricut. Printers window of the Control Panel.

2 Devices a d Printers

<« ~ /~ $2 > Control Panel > Hardware and Sound > Devices and Printers >
‘ Add a device

Add a devic Add a printer Remove device

Installing CricutflIR2-27E0 i - .

Anker A" 108 DESKTOP FNN3I  Gregory's iPhone

PIE e wait while Setup installs necessary files on your system. This may take v Printers (5)

_J (s w==u=s

Microsoft Print to Microsoft XPS NPIg18BA0 (HP Send To
Document Writer Color LaserJet OneNote 2016
CP2025dn)

 Unspecifiec (1)
72

CricutAIR2-27E0

. CricutAIR? 27E0  Model: Bluetooth Peripheral Device
Once connected, you can select your machine ! gy Ol
from the drop-down menu in Cricut Design Space.
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HOW TO ATTACH

TO KEEP THINGS TOGETHER

Did you click Make It and find all of your elements re-ordered and out of place? Fix this and keep
everything exactly where you want with the ATTACH button. Use Attach to hold your cuts in the same
position relative to each other on the cutting mat. The Attach feature also helps you affix a write or

score layer to a cut layer.

Step 1: Add all of your elements to Cricut
Design Space, including text, SVG designs,
score lines, write lines, etc.

~ Group
~ Heart

W e

Toxt - Cricut Sans

*. C omeca

— |
| | .' ol —
Cricut |

{0 {o 2 8 e {2 o |

Step 3: Select any layers (two or more) you want
to attach together (hold down the Shift key
while you click to select multiple layers), then
click Attach in the lower right corner.

Note that attached layers will take on the same
color. So only attach layers that you really want
to be the same color!

Step 2: Ungroup any groups. To do this, 7
click on any layers called Group and
UnGroup

click the Ungroup icon.

v
Cricut

o {e 3 {0 (= {3 o [

Tip: If you are having a problem attaching
layers, try ungrouping layers first.

Score lines must be attached with the
appropriate cut layer in order for them to
score on the right layer, as shown below.

o cro
R
- To-Groane
| et
« hnaen
~ e

Cricut —

o =

e {» w3 {0 e {2 o [l

Tip: Layers may change or re-arrange when
attached. To update your layer order, select an

layer, click on , and select a new
order.

Practice this at https://jennifermaker.com/i-love-cricut

PAGE 9 ¥V COPYRIGHT JENNIFERMAKER®
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HOW TO
GROUP AND UNGROUP

Grouping lets you keep objects together in your design but not necessarily on your mat (you still need to
use the Attach function to keep things together on the mat). Sometimes projects and uploaded images
will be grouped when you open/insert them, and you’ll need to ungroup them so you can make changes.

HOW TO GROUP:
Step 1: Select each layer in the Layers panel you Step 2: With all objects you want to @
Group

GROUP / UNGROUP

want to group together. Alternatively, you can be in a group selected, click the Group
click and drag a rectangle to select objects. button at the top of the Layers panel.

{0 {® 3 {9 (e {0 e |
{0 {® 3 {9 ({0 e |

HOW TO UNGROUP:

Step 1: To ungroup, start by looking for the word Step 2: With the group selected, click
Group in your layers panel and click it. the Ungroup button at the top of the
Layers panel.

You often need to ungroup before you can attach objects. Sometimes,
a project or image set has multiple groups. So if you want to attach
and have an issue, look for ALL groups and ungroup them first.

Practice this at https://jennifermaker.com/smiley-face
PAGE 10 VY COPYRIGHT JENNIFERMAKER®



http://jennifermaker.com/smiley-face

CRICUT® COACH PLAYBOOK

HOW TO WELD

Desktop

Need to join elements to create a new image? Do it with the Weld tool! The Weld tool can simplify a
design, keep the letters of a word connected, and combine shapes to create new designs.

Step 1: Insert any images you want to Step 2: Select all images to be welded
weld onto your Canvas. together. then click the Weld button in
the lower right corner.

~ Butterfly Garland.
W s

- Butery Garand
By sescon

- Buterty Garand
fascou

~ Butterfly Garland.
W sescon

- Butery Garand

W Basicou

2

M
-
-
T
@ -
o -

Tip: You can select items within groups to weld
by clicking on their names in the Layers panel
while holding down the Shift key.

Note: If you are trying to create a single image with
Weld, make sure all elements are overlapping.

Once your images weld, they will change to the
same color and a new image appears in the Layers
panel.

Note: You can unweld ONLY if it is the current
project on your Canvas and you recently welded
it. In this case, you can click the Undo button
until you unweld the image(s).

Carjvas

® ()

0 ‘1 2
0 0 0 O P00
- |
|
|

b I Weld is like permanent glue. Use Weld when you want to eliminate the cut

.
e lines between two images or letters. Weld keeps your project together on
\‘ the canvas and when you send it to the mat to cut. But beware, there is
coeR) no Unweld button (only Undo). Weld is permanent!

Practice this at https://jennifermaker.com/butterflies

PAGE 11 ¥V COPYRIGHT JENNIFERMAKER®
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Desktop |
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HOW TO SLICE
(CUT ONE IMAGE OUT OF ANOTHER)

Want to cut out parts or even make your own custom designs? If so, Slice is the tool for you! Slice lets you
cut out parts of another object. If you keep slicing, you can make some pretty amazing designs!

Step 1: Insert your images onto your
Canvas so that they are overlapping.

o {® {0 e {9 e

[ ] e

> N =3

After you click Slice, three or more new layers
called “Slice Result” will appear.

~ Slice Result

' Basic Cut

~ Slice Result

g e

3
&
H

F
H

Basic Cut

~ Slice Result

R {» =2 iR

f

Slice Tips:
« You can Slice both images and text.

e {® =3 i@ o {9 10

Step 2: Select just two layers (hold the Shift RF}
key as you click each layer), then click Slice. S

i 3 {8 @ {3 ®

£
&

Step 3: Move, hide, or delete the layers you
do not want, then you’re good to go!

~ Slice Result

W sescon

~ Slice Result

Basic Cut

~ Slice Result

Basic Cut

 You can only Slice with two layers. If you have multiple images you want to Slice out of another, use

the Weld tool on the multiple images first.

 Layers in groups can be Sliced if you select just the individual layers, not the entire groups.

o If you use Slice with hidden layers, all hidden layers will be removed.

o If text is multi-layered and one layer is hidden, you can use the Slice tool. However, if you ungroup
text from its shadow layer, it becomes an image and will no longer work with the Slice tool unless the

text is ungrouped to individual letters.

Practice this at https://jennifermaker.com/heart-slice

PAGE 12 ¥V COPYRIGHT JENNIFERMAKER®
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HOW TO REMOVE
PARTS WITH CONTOUR

Need to erase parts of an existing design? Don’t want that word or that circle, but can’t ungroup or hide
a layer? Use Contour to remove existing parts from projects.

Step 1: Choose an image with Step 2: Click on the elements you want to
elements you’d like to remove then = remove. If you want to remove all elements
click the Contour tool in the lower 4 A, (contours), click the Hide All Contours button.
right corner of the app window.

Contour
Hide All Contours

Hide Contour

‘On image below, select outlined portions to turn cut off and on.

i@ i@ =3 I8 {z {2 ©

Step 3: Elements that appear darker are those Step 4: Confirm that your image looks the way
that you’ll keep. When your image looks the you want it. If you need to make more changes,
way you want it to, click the X in the upper just click the Contour tool again.

right hand corner to return to your canvas.

Hide Contour

On image below, select outlined portions to turn cut off and on.

CONTOUR (REMOVE BITS)

o e m I8 im {2 @

Tip: Contour isn’t permanent so long as you don’t Weld your images! If you decide later you want a
Contoured image to go back the way it was, or simply edit it further, all the hidden parts are retained!

Practice this at https://jennifermaker.com/svg-heart
PAGE 13 Y COPYRIGHT JENNIFERMAKER®
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HOW TO
CURVE TEXT

Step 1: Click the Text tool and Step 2: Select the text and click
add some text. (You do not need the Curve tool at the top. The
the rainbow—I added that so we slider allows you to adjust the
could compare the curve to it.) : curve up or down.

19 19 o 1B 43 |3 10

-;
- e
Coamra v e

- Dowhat you
0 e

A

e jo =3 {0 o {0 o [

CURVE TEXT

Step 3: Slide the slider to the right for a Step 4: Slide the slider to the left for an
downward curve. The more you slide, the upward curve. The more you slide, the
tighter the curve. tighter the curve.

0 je 3 {F iz {0 o [
0 {® 3 {8 iz {0 o [

Tip: You can change the
font, color, size, line
spacing, etc. at any time
(so long as you don’t
flatten or weld it) thanks
to this curve text feature!

Practice this at https://jennifermaker.com/rainbow-love

PAGE 4 ¥V COPYRIGHT JENNIFERMAKER®
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HOW TO ALIGN AND
DISTRIBUTE OBJECTS

Step 1: Add two or more items to your canvas Step 2: Click and drag a selection box around
that you want to align or distribute evenly. all items you want to align and/or distribute.

16 1o 04 1 43 |2 15

A

ALIGN AND DISTRIBUTE

2

2

icieieciei™

e {® 3 {8 = {2 o [l
e jo o3 40 ju {2 1
<
2

Step 3: Click on the Align tool in the ' Step 4: All selected items are aligned with the
toolbar and choose Align Top. topmost object. Now let’s space them evenly.

® ®

T -
& 2 -
e &
T TE
& 8"
e e

Step 5: Click the Align tool again and this time Step 6: Note that all the hearts are now in a
choose Distribute Horizontally. perfect row with the same spacing.

o {o =3 | o {3 ©
fe ie 3 B {z {2 © [

Practice this at https://jennifermaker.com/five-hearts
PAGE 15 XY COPYRIGHT JENNIFERMAKER®
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HOW TO KERN &
CHANGE LETTER SPACE

Kerning is when a font’s letters are arranged in a pleasing way rather than spaced oddly. Kerning is
automatic for many—but not all—fonts in Cricut Design Space. Here’s how to identify which fonts will
kern for you automatically and what to do when you need to fix a font that is not kerned.

15 1o o440 I3 [ 16

Step 1: Click Text, choose a font, Step 2: Type your text and see it kerned!
confirm that Only Kerned Fonts is Compare the kerned line (top) with a line that is
checked, then choose on a font. not kerned (bottom) to see the difference!

JenniferMaker*

7 B

UG Dupleste  Dae

Fonts Al System Cricut  SearchFonts B Only Kemed Fonts @ J) Fiters 1|
A S T he quick hrourn o
P The g broun fo jums oer the bz dog
: - the Q uick BROwOI
The quick brown fox ?

Th i v e n @’é h@’bﬂ/ @CL

\
‘o 616" Q ° ‘

~ Text- Alyssa Stencil Script @

Y easocu

g 1®

£l
£
&

b mec

B
| I

I | ~ Text- Ayssa Stencil Script @
1

|

|

|

|

Bl {ra

i

jo 123 {8 (w2 @ [l

Note that text in older projects may not Kerned fonts are automatically welded after
automatically be kerned. To fix this, click on you click Make It, so there is no need to weld
the text, and then if it is a kerned font, it will manually unless you ungroup your text.
automatically kern the text.

If your font isn’t kerned, here’s how you can manually change your letter spacing:

Step 1: Identify text that is not kerned by how Step 2: Select the text and click g S
the letters do not seem to fit together well, like the down arrow in the Letter Space ¥ i E]

this text below: box until the letters look better.

~ Text - Cricut Alphabet
D suseou
D s ow

i iR m i @ [
» 13 {8 o {2 e [

from the “h” — select the text and click it to the right, holding down the Shift key to
Advanced then click Ungroup to Letters. keep it in line. When you are done, select all
letters and click Attach to cut them together.
If your letters touch, click Weld instead.will

Step 3: The letter “w” is too far away P Step 4: Select just the letter “w” and move
Eli ¥

:ﬂ)o what&}ou lovd:w

El Ungroup to Letters

' :ﬂ)o what you lovq:w

[ Ungroup to Layers

T

ie {» m B (o {2 o[l
v e i@ e {2 e [
KERN & CHANGE SPACE

Practice this at https://jennifermaker.com/rainbow-love
PAGE 16 XY COPYRIGHT JENNIFERMAKER®
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HOW TO WELD TEXT
AND KEEP LETTER CENTERS

Welding text can be a little tricky. Typically, you weld script fonts (which can have overlapping letters) so
words cut out as single units. Sometimes when you weld, the centers fill in—here’s how to fix that:

Step 1: Click Text, type in script Step 2: If you get a center filling Step 3: Repeat step 2 until you
text, change your letter spacing in (like the p’s descender here), can weld and the letter center
so they are overlapping a bit click Undo, then use the Resize does not fill in (you may have
(see directions on page 16), handle to make your text MUCH to get REALLY big), then resize
click Select All, then click Weld. larger, then click Weld again. back down to the right size.

je 2 I8 o {2 o [

e ie 3 (@ {u {2 o

| (2
~y
B

Another thing that can happen with text is that letter centers (the interior white space) can disappear
when you cut them out. But you can connect the spaces and keep the centers! Here’s how to fix that:

Step 1: Click Text, type in your Step 2: Click Shapes, select a Step 3: Click and drag the
text, and look for letters with square, and unlock it and resize rectangle over a letter with
interior white space (counters), it so it forms a rectangle about interior white space so it’s
like these letters (A, B, D, O, P, the width of the connecting the space inside to

Q,R,4q,b,d,e,g,o,p, q)and letter’s strokes. _ the space outside, like this:
numbers (0, 4, 6, 8, and 9)

e {e 3 @ = {3 o [

Step 4: Select the word and the Step 5: Delete all layers Repeat steps 2-5 for
rectangle, then click Slice. except the word layer. Delste all letters as needed. Adore

el P Ly Courpe
e E e = e - - " »

Adore

ko - I - . [_‘_.,,_ -
QR ; S22 i 3

Practice this at https://jennifermaker.com/script-text and https://jennifermaker.com/adore-text

2
o
L}

- Stcn Resut

A G

e lo = 8 {w {3 1@
io o =2 {F {u {0 o [
e {o 3 @ jz {3 1@

KEEP LETTER CENTERS

PAGE 17 ¥V COPYRIGHT JENNIFERMAKER®
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HOW TO
OFFSET & KNOCKOUT TEXT

Offset and inset is a beta feature of Cricut Design Space that allows you to create outlines around or
within text and images. Here’s how to use the offset feature to make a knockout design.

Step 1: Click Text, type in your Step 2: Click Text, type an accent|l Step 3: Select the accent word
main word using a bold font like word in a script font (i.e., | Love layer, click on Offset, and slide

Cricut Sans Bold. Unlock ) Glitter). Adjust lettering ) the distance bar to the |-
it, resize it to make it as needed, unlock it, el right about .1 inch, then

taller, and click Weld. Weld resize it, and click Weld. click Apply.

RATL

je 3 (8 {2 {2 @ [l

Step 4: Select and separate the Step 5: Position the offset layer Step 6: Delete the sliced out
new offset layer, which you can over your main word, layers by selecting and
I?éb
Slice

clicking the Delete button. BT
In this image, | moved the

layers to see better.

see looks similar to the accent select both layers (and
layer but is thicker and bolder. only those two layers),

: : o
and click Slice. clete

fo {® = I8 {z {2 o [
fo {e m i@z {0 o |
1o o = 8 ju {3 o [

Step 7: Click and drag the accent word inside the empty space sliced out of the main word, with the
accent word selected, click the color box to change the accent word color if desired, and click Make It!

Operation Deselect  Edit  Offset Align Flip Size 5} Layers Color Sync
Basic Cut i+ i=v Didv W 5914 & H 2043 &  Morev = o & W
3 5 7 8 19 Group UnGroup Duplicate Delete

@ [H ~ Slice Result @

Templates 2 JEAVTA Basic Cut

~ Weld Result

Basic Cut

OFFST/KNOCKOUT TEXT

Practice this at https://jennifermaker.com/beautiful-knockout
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https://jennifermaker.com/beautiful-knockout

CRICUT® COACH PLAYBOOK

HOW TO

KNOCKOUT (ALTERNATE)

Knockouts (see previous page) are a popular decorative effect made with offset. Not all Windows users
have the system requirements to use Offset, however, so here is an alternate workaround:

Step 1: Click Text, type in your
main word using a bold chunky
font like Cricut Sans Bold.
Unlock it, resize it to make it
taller, and click Weld.

Step 4: Click Make It, click
Continue, click Send to Printer,
toggle on Add Bleed.

Step 7: Return to Design Space,
cancel everything until you’re
back to your Canvas, then
Upload the file you saved (look
in your Downloads directory).

Step 10: Delete the three sliced layers (leaving the

Step 2: Click Text again, type an
accent word in a script font (i.e.,
| Love Glitter). Adjust lettering
as needed, unlock it, resize it,
and click Weld.

- v Resut.

=

Step 5: Open the Snipping Tool
by searching for “snipping tool”
in the Search Box next to the
Start menu. Once found, open it.

Step 8: Select Simple as

your image type, Erase the
background, and click Continue.
Then click Save as a Cut Image
and click Save.

Step 3: Select the main word
layer and click the Eye icon to
hide it. Select the accent word
layer, go to the Linetype menu,
and change it to Print Then Cut.

o i® 3 i@ [m {2 1©

Step 6: With the Snipping Tool
open, click and drag a box
around the words inside the
box, then save the snipping to
your hard drive.

Step 9: Insert the knockout on
your canvas, resize it to match
your accent word, unhide your
main word, position the knockout
over your main word, select both

main layer), click and drag the accent word inside the
empty space sliced out of the main word, with the

accent word selected, click the Operation menu and
change it to Basic Cut, click the color box to change
the accent word color if desired, and click Make It!

- VRNV Ve

Practice this atmtgs:// jennifermaker.com/beautiful-knockout

PAGE 19 ¥V COPYRIGHT JENNIFERMAKER®
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CRICUT® COACH PLAYBOOK

15 1o o440 I3 [ 16

HOW TO CHANGE THE
FONT FOR EXISTING TEXT

Step 1: Open your project and double-click the
text you want to change the font for.

o
- 9

;@cut rocks!

2
nIs
o
=
z
o2
-

Step 3: Choose a new font from the list that
appears. If you don’t see the font you know is
there, uncheck the “Only Kerned Fonts” box to
see ALL fonts available.

The quick brown fox jumps OV e laz, e
The quick brown fox jumps over the lazy dog 12345678
The quick brown fox jumps over:
The quick brown fox jumps over the lazydo [ |
The quick brown fox jumps over the lazy d
The quick brown fox jumps over the lazy dog 1234567

fo {o 3 {8 o {0 o [l

While you can’t change a font
you’ve welded (unless you’re
able to Undo and unweld it
because you haven’t saved
q 4 and reopened your project),
there is a way to tell WHICH
/ g font you used so you can

conet re-create it. Locate the weld
layer with the text, right-click
on the layer name, and choose

Image Info at the very bottom.
A box will appear that shows

e {o 3 {8 {® {2 © [l

Step 2: Click the drop-down font menu in the
upper left corner.

i
§

ii‘r@ I
2

ot rocks]

Cricut rocksl -

fe {o =2 B {®

Your font changes!

i {o =2 {8 {w {0 © [

you what font was originally
used.

PAGE 20 YV COPYRIGHT JENNIFERMAKER®
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CRICUT® COACH PLAYBOOK

HOW TO CHANGE
COLORS AND PATTERN FILLS

Step 1: Select (click) the layer you want to change, Step 2: Click the square to the right of the
like the center of this flower. When selected, it Operation menu and click a new color. Click
turns a darker gray in the Layers panel. Advanced to choose a custom color.

15 1o o440 I3 [ 16

e i® 3 I8 {u g o[
i0 {o =2 iF {m {2 o |

You can also give objects a pattern fill. Be aware that changing an object to pattern fill will also change it
to a print then cut image. Here’s how you set pattern fills:

Step 1: Select the layer you want to change, then Step 2: Click the Fill menu and change the Print
click Operation and change it to Print Then Cut. Type to Pattern.

(%]
-
=
L
N
(%)
4
o
-
o
O
L
O
r4
<
T
O

0 jo =2 iE {m {3 o |
0 jo =2 iE {m {3 o |

Tip: You can edit the scale, rotation, and
orientation of the pattern by clicking
Edit Pattern and making changes!

Edit Pattern

o jo =2 {8 {m {2 0 |

Practice this at https:jennifermaker.com/sunflower-colors
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CRICUT® COACH PLAYBOOK

HOW TO CHANGE
OPERATION AND TOOLS

The Operation menu lets you change a layer’s type. Choices for the Cricut Joy are Basic Cut (default) and
Pen. The Explores add Score, Foil, and Print Then Cut Standard. And the Cricut Makers add to this several
more choices: Wavy, Perforate, Deboss, and Engrave. You will only see the Makers’ operation choices if

you’ve set your machine to Maker or Maker 3. Here’s how to set your machine and change the operation.

Step 1: Click the menu to the
left of the Make It button and
choose your machine.

My Projects  Sa@ Maker3 v Make It

Optimize experience for:
Cricut Maker 3 i
Cricut Explore 3 Luu
Cricut Joy E

Cricut Maker

Color Sync

@

Cut

 Cricut Explore Family

=

Change your operation to Wavy
to use the Wavy Edge Tool or to
Perforate to use the Perforation
Tool (Makers only).

Duplicate Delete

o fo =3 8 {m {2 o [

Change your operation to Score
to score with the Stylus (Makers
or Explores) or Scoring Wheel
Tools (Makers only).

Step 2: Select (click) a layer and

click on the Operation menu at
the top to see the options.

e o =23 {8 {z {03 o [

Change your operation to Pen
to write with pens and markers.
Click the box to the right to
choose the color and thickness.

e {o =3 {8 {u {3 o [

Change your operation to
Deboss to use the Debossing
Tool, or to Engrave to use the
Engraving Tool (Makers only).

e Io =2 8 o {3 o [

Practice this at

Use Basic Cut for fine point, deep
cut, fabric, knife (Makers only),
or rotary (Makers only) blades.

e o =23 {8 {z {03 o [

e {® = if {m {J e

tt

e o 8 {n {2 © [

Change your operation to Foil to
use the Foil Transfer Tool, then
chooose the tip size (Explores
and Makers only).

Change your operation to Print
Then Cut Standard to use the
Print Then Cut feature (Explores
and Makesr only).

s:// jennifermaker.com/starry-star

PAGE 22 <Y COPYRIGHT JENNIFERMAKER®
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CRICUT® COACH PLAYBOOK

16 1o 04 1 43 |2 15

HOW TO SET TEXT TO
WRITE WITH A PEN

You can insert a Cricut pen or marker into any of the Cricut Joys, Explores, or Makers and have them
draw for you. Many crafters like to use this feature with a writing font to mimic handwriting. Here’s how
to choose a good font that looks like handwriting and set it to Draw in Cricut Design Space:

Step 1: Click Text, click the Font menu, click Step 2: Select a writing font (such as the free
Filters, and select Writing to see writing fonts. Cricut Sans or Cricut Alphabet font), click the
Note that some may have a fee, like this: Style menu, choose Writing, and type some text.

Fonts

Search Fonts Gow UnGowp  Duplcate  Deete

s " - Text- Cricut Alphabet ®
@ Singl-Layer Guting Wting A - Regular W

T
AyssaStnci crt R ulti-Layer I - talic
@ Single-Layer Cutting Writing ‘ 1

Skt jals B-Bold

BI - Bold ltalic

Step 3: Click Operation, select Draw under Pen, Step 4: Adjust the Font Size and Letter Space
then click the square to the right of Operation, as necessary so it looks the way you want it to
and select a pen type and color. look, then click Make It.

i

Color Sync.

2 ® W
) UnGrowp  Dupicats  Delete
T~ Text- Cricut Alphabet ®
v

LR

ok
g
4
H
{3

Pen Pen

1

e o 3 (@ {1 {38 @

i

fe {» 3 {8 {n {3 @

Step 5: Click and drag the text to the exact spot Step 6: Insert the pen in your Cricut’s accessory
you want it to be written on your material on the clamp, position your material on the cutting mat,
machine mat (see page 25), then click Continue. load your mat, and press the flashing button.

See my blog post at

cricut-writing for more
tips on writing on your
Cricut! | also have a free
writing font you can use
at jennifermaker.com/

WTrite ool

Practice this at https://jennifermaker.com/write-on
PAGE 23 Y COPYRIGHT JENNIFERMAKER®
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CRICUT® COACH PLAYBOOK

16 1o 04 1 43 |2 15

HOW TO SCORE WITH
STYLUS OR WHEEL

Step 1: Open or create a project with score
lines. You can add a score line to any project by
clicking Shapes, then selecting Score Line.

Step 3: Make sure the score line is on the same
layer as the cut, then click Continue.

Step 5: Click on the scoring tool of preference,
then click Continue.

Tool options

Please select your options below

Scoring Tools Blades

G

Scoring Wheel Fine-Point Blade
(Recommended) (Recommended)

Step 2: Make sure any lines you want to be
scored are identified as “Score” (click the
Operation menu to change) and are also attached
to the cut layer you want to score. Click Make It.

Step 4: Check the necessary tools. If the screen
says to use a scoring wheel but you do not have
one, click Edit Tools.

Maker : 4392 (Bluetooth)

20 |b

Pressure.
Defautt

@ Load tools and mat

1y

Load Scoring Wheel in Load mat and press
Clamp B Load/Unioad button @

Step' 6: Insert the :??S'J';Gt
scoring tool that

matches step 5, ‘ SCORING
then click the ‘
flashing icon on —
your Cricut.

WHEEL

Practice this at https://jennifermaker.com/love-card
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CRICUT® COACH PLAYBOOK

HOW TO REPOSITION
ITEMS ON MAT PREVIEW

Need exact control over where items on your mat are cut? Want to cut one mat with multiple pieces
of paper in different colors? You can do this if you reposition items on your mat before you cut! Here’s

how to do it on a computer (Mac or Windows):

Step 1: Open or create a project. Make anything
you want to appear on the same mat the same
color. Click Make It.

Colorful Butterflies by JenniferMaker*

~ Butterfly Garland
W sescou
- Butterty Gartana
D sascon
- Buttery Gartana
W Bascon
~ Butterfly Garland
W eascoa

~ Butterlly Gartand

W BasicCut

fe {» =23 {8 {2 {0 o |

Step 3: Move each object on the mat by clicking,
holding down the mouse, and dragging to a new

position. You can also move and hide by tapping
the three dots icon on an element.

Step 2: Make sure the items you want to
reposition are all on the same mat.

Step 4: Make sure the material on your actual mat
matches the placement on this mat preview, then
click Continue.

Practice this at https://jennifermaker.com/butterflies
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CRICUT® COACH PLAYBOOK

HOW TO MIRROR AND
CUT IRON ON VINYL

Want to make a T-shirt or bag with iron-on vinyl? Here’s how to mirror your image and position the vinyl
on your mat for iron-on (heat transfer) vinyl!

19 1o o4 (B {3 |3 19

Step 1: Select all the objects you want
to iron-on and click Attach.

MIRROR IRON-ON VINYL

o c o uneopn e oo £t e s p
Ddv  wiosm ¢ mormes Ol g Mer & s W wmc /B DBdr  woms § wuames Oo g e

i - @
19| [2A] T2a] los] lor| [os| [s] [ss] [ss] lor| |ss| [e1] lao] las| lar| las| |e @ow Dikous | e o1 | fa| Is| [ lof [l lsal [is] [rr] [to] [a] [es] los| lor| leo| [si[ [ao] las| lor| fas| lat] [as] las] lar] las| le Dute
~ Text- Criout Font & Basic ..® . . ’ o
S=—— e s I |
8 o ) — § ~ Text- Cricut Font & 8a...
- i Resut B / \ $ -
o~ i ~ Sico Result ®

(X3

19 {® 3 P {2 {3 o [

CECEENEERENENEEEE!

Step 3: Toggle Mirror to the on position, verify Step 4: Connect to your Cricut and click
your image is now mirrored, and click Continue. on Browse All Materials.

@ Set material

Favortes

Gardstock
Medium Cardstock -
801 216 gsm) 10(163 gsm)

T Copy Paper~201b
12X 12" Mat; itor On Edt P

€

Fabr Fabric Fabr
Heavy Fabrics (ike  Medium Fabrics (ke  Light Fabrics (ike Faux Leather (Paper
Denim) Cotton) siig Thin)

¢

Step 5: Search for “iron” and select the type of Step 6: Place your iron-on vinyl on your cutting
iron-on vinyl you plan to use, then click Done. mat shiny side down, insert the mat, and press Go.

All Materials
Maker : 4352 (Buetootr)

AiMaterals  Fevortes
@ Material set to: Everyday Iron-On

13 results ~
A

v Everyday Iron-On

Flocked Iron-On Ereseire)
Defeut
ol on-On
Giter on O @ Load tools and mat
Heat Tianster
—~
Hologaphi Heat Tanster — ()
(N
Holographic Sparkde Iron-On {x

ron-On

ClampB® Load/Unioad button

Pattered Iron-On

Printable Iron-On, Dark
Printable ron-On, Light

SoortFiax lron-On.

Material Settings

Practice this at https://jennifermaker.com/simple-smile
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CRICUT* COACH PLAYBOOK b B

HOW TO
USE A TEMPLATE

Step 2: Choose a template that best fits your

Step 1: Open a new project and click
ﬂ\_? project. For example, to make a monogrammed

the Templates button on the left side.

Templates

pumpkin, | will choose Jack-O’-Lanterns.

All Canvas Types.

Hot pads Infant seat canopy

Templates

2 {© =3 [ i

Jeans. Jewelry

Step 3: Immediately, choose a style and/or size Step 4: Click the lock icon to unlock it, then type in
from the drop-down menus at the top. the dimensions of your actual item so the template
matches. You can also change the color.

y i@ 3 {6 o {2 © [

Step 5: Resize your Canvas so you can see most Tip: You may need to add or subtract if the shape
or all of the template by using the doesn’t quite match your item. For example, the
buttons in the lower left corner. isE=====za=m stem on this pumpkin is significantly taller than

the one I’m using.

| : — - =
e : - %—‘ "
B, \\\ Tip: You can modify your S0
= EER REPZ7Z ZAA SR template at any time by i
o K Y AN clicking on the template
e | f’/ ! \\ i name in the bottom right
e M I corner of your screen. If you
§ i \\' \ / ] ,s' no longer want to view the
A IRay template, click the ,
\ e ’ /
\ \_\ Jv/////// e eye icon to hide it. @

Need a template but can’t find it in the template library? You can upload your own
image (see page 38), resize it as needed using the dimension boxes at the top of

the screen, and then click Arrange > Send to Back. Be sure to hide the layer

(click the eye icon) before you cut it to avoid cutting out the template, too. @
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HOW TO SAVE WORK
AND VIEW SAVED PROJECTS

Step 1: Create something and click Save. You can Step 2: Type a name for your project,
tell if something is unsaved if an asterisk * appears check any collections you’d like to add it to
next to the name at the top of the window. (optional), and click Save.

Save Project As

Save To Collections

Playbook

Available Collections (¥ New Collection

e {o 3 {8 jo {2 o [

[ 3D Designs [ Alexa's Projects
[ Cricut College [ Flowers

[ Vinyl Projects.

=

Collections allow you to organize projects you
create for ease in finding them later. Click New
Collection to create a new category. All Cricut
members can create up

to five free Collections. New Collection
Cricut Access subscribers
can create unlimited
Collections.

SAVE WORK/PROJECTS

Step 3: Wait while Cricut saves your project—
when saved, a blue confirmation box will flash
near the top of your screen and the new name
will appear at the top of the window.

e.g., Birthday Card

® im ISR <

To view your Saved Projects, click To share a project, click on the Share
the My Projects link in the top right button on the bottom of its box, then
corner of your window, or click the click Copy Project Link to copy the URL
Projects icon on the left side of the and then share it with someone as a
window and select “My Projects” link or in an email.

from the Projects drop-down menu.

1Al My Projects (578) Share Share

Al My Projects
Facebook Facebook

LY -~

v E Link copied to clipboard
oee ~

Love Decal ignto Shine T:Shirt .. (2]

& «

Pinterest Pinterest

Copy Project Link (&) Copy Project Link

ie o o3 i {m o o [

Note: Projects with uploaded images can

be saved and shared, but they can only be
customized and made by you—others will not be
able to open and make them.

Desiar to Shine Free Fo... (21 Shine T-Shirt

Practice this at https://jennifermaker.com/love-decal
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CRICUT® COACH PLAYBOOK

15 1o 02 @ {3 {2

HOW TO
SAVE FOR OFFLINE WORK

If you’re using Design Space for Desktop (see pages 4 and 5), you can save projects for offline and
access them even when you aren’t connected to the Internet. Here’s how to do it:

Step 1: Click the menu in the upper left, choose
Settings, and select Cloud & Computer.

Design Space Settings

Language

Step 3: In the panel that appears, click Save
for Offline.

All My Projects

Round Door Hangor Ideas
3

578 Projects.

Designto Shine T-shirt .. (2]
3

2
2
2l
&
g
=2
2

When you lose Internet access, you are notified and
any projects you’ve saved for offline are listed.

Hmm. Looks ike your connection was lost. But keep working! Only certain features and content will be unavailable.

Step 2: Click on My Projects, find a project,
and look for the Offline icon. If you see it,
the project is saved for Offline. If you do
not, click the three dots. X3

1 Al My Projects (578)

Collections @ New

Cricut College (13)
Flowers (17)
Mugs (25)
Playbook (17)
Vinyl Projects (1)

Design to Shine T-Shitt ...

Confirmation that your project saved succesfully
appears at the top of the screen.

Al My Projects (578)
Al My Projects

Collections @) New
578 Projects
30 Designs (12)

Alexa's Projects (20)
Gards (30)

Cricut College (13)
Flowers (17)

Mugs (25)

Playbook (17)

Vinyt Projots (1)

LoveDocal £ FoundDoor Hanger lees 2 Design to Shine T-Shirt ... (2]

<

Open the project and continue working! The
“Offline” indicator stays lit when offline. (= offine

MyPojects Save |  Explore

ojects > My Projects My Projects

LY
VE

e There is currently no way to batch save all of your projects for offline. You must click each one and select

“Save for Offline” individually.

o If you are working offline, and the online version is not synced up to the offline version, the next time
you go online a pop-up will appear asking you to select a version to keep.

» Any images you have in a project from Cricut Access will expire after 30 days if you do not go online at all
during those 30 days (even if you have monthly access). So be sure to set a reminder to go online at least

once every 30 days.

» You cannot upload anything new while offline (this means even from your desktop or images within Design
Space). So be sure to save all images you want in a project/canvas before heading offline.

Practice this at https://jennifermaker.com/love-decal
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HOW TO
SHARE LINKS TO PROJECTS

Did you make an awesome design and now want to share it? You can share projects, but in order for
someone else to open and make them, there must be no uploaded images in your project. (Others cannot
open and make projects with images you uploaded.)

Step 1: Open a project you saved and Step 2: You will likely be prompted for more
click Share. information first. Click Add Details.

Note: If your design
has any purchased
elements from Cricut
Access or cartridges,
To share this project, anyone attempting to
add more info. use your design must
also have them or

they will be prompted

to pay for them.

{o {® 3 i@ |z {3 1©

Step 3: Add at least one landscape photo by Step 4: Add a description and make sure Anyone
clicking the + button. with link is selected. When done editing, click Save.

Step 5: Click either Facebook or Pinterest, If you share a link with uploaded images, this is
then simply click Copy Project Link. what others will see.

Fantastic! Your project is ready to share. '
< WO
0.

Siant Lace Paper Flower

Q‘ JenniferMaker Marx

@ This project cannot be made or customized.

Here is an example of a project link: https://design.cricut.com/landing/project-detail/609ed93969c5040d507810c5
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CRICUT® COACH PLAYBOOK

HOW TO
LINK CARTRIDGES

Step 1: Open Cricut Design Space, click the
menu in the upper left corner, and choose Link
Cartridges. If you’re using a Cartridge Adapter, it
will need to be inserted into a USB port on your
computer first.

NEw Machine Setup
ibration
nage Custom Materials
ite Firmware

ount Details

Link Cartridges
Rainbow

Cricut Access o e Share

Step 3: Once the cartridge is detected, the Link
Cartridge button will become available. Click the
Link Cartridge button to continue.

Link cartridges

ExploreAir2 : 100F (USB)

Insert cartridge
Insert into port on top left side of machine.

Link cartridge

Click the bution below o continue. Please note that cartridges can only
be linked to cne Cricut account

When a physical cartridge has been linked to your
account, the digital versions of those images are

activated on your account and the physical cartridge

is no longer needed in order to use those images
with Cricut Design Space.

Link digital cartridges at https://www.cricut.com/CTMH

Love Decal

Step 2: Choose your Cricut from the drop-down
menu. If you do not see it, make sure it is turned
on and connected. For best results, connect your
Cricut to your computer via the USB cable.

Link cartridges

ExploreAir2 : 100F (USB)

Insert cartridge

Insert into port on top left side of machine.

Step 4: Once the link is complete, remove the
cartridge from the adapter and choose what
to do next. You can continue to link other
cartridges, view your cartridges, or close the
window.

Cartridge linked

‘What would you lke to do now?

S

Link anciher cartridgs “igw your cartidgss

Tip: If you have issues linking your cartridges,
contact Cricut Member Care for assistance
getting them uploaded to your Design Space
account. Note that they may ask for photos of
the cartridges to do this.

Note that you cannot link physical cartridges on iOS or Android devices at this time.

PAGE 31 ¥V COPYRIGHT JENNIFERMAKER®

LINK CARTRIDGES



https://www.cricut.com/CTMH
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HOW TO
FLATTEN AN IMAGE

Need to make a Print Then Cut project? Flatten is your friend! The Flatten tool allows you to turn any
image into a single, printable layer for the Print then Cut feature.

Step 1: Add two or more items
to your canvas that you want to
flatten.

Note: Flatten is used only for
print.

i o 3 {8 {o {9 @

Step 2: Click and drag a selection
box around all objects you want to
flatten to select all of them.

FLATTEN AN IMAGE

Step 3: Click the Flatten
icon in the bottom right Qb
corner. N

Flatten

Note that all items are
now on one layer and now work
only for Print Then Cut.

If you decide this isn’t
what you wanted to
do, click the Unflatten
button right away.

e {® =3 (@ {m {

Practice this at https://jennifermaker.com/five-hearts
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Step 1: Find or upload a printable image less than 9.25” high by 6.75” wide with one of these two methods:

Method A: Search for printable images in Design
Space by clicking on Images, then under Operation
Type, check the box next to “Print then Cut.”

e io m3 @ {z {3 o [

CRICUT® COACH PLAYBOOK

Tip: Click “Free”
under Ownership on
the search page to see
all images that are set
to free for anyone to
use.

Step 2: Select and insert

the image onto your Canvas,

then click Make It.

Step 5: Select your printer,
turn on Bleed, and click
Print.

PAGE 33
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Method B: Upload a PNG with a transparent
background, choose the image type that suits your
image the best (I recommend “Complex”), then
click Continue.

Select image type
Your image will be uploaded as a single layer.

How complex is your image? Select an option below that best matches its

complexity. nag

Simple

Image with high-contrast colors and a transparent

‘or monochrome background.

Moderately complex

‘Simple details and color, with good contrast
between subject and background.

Complex

Erase anything you don’t
want & click Continue.

Category: All Images

Layers

Ownership

[0 Uploaded
[J Purchased
Free

[J Downloaded

e ie w3 {8 ju {3 o

Step 3: Make sure you see
“Print Then Cut” here,
then click Continue.

Step 6: Select your Material
(i.e. Printable Vinyl).

Practice this at https:// iennitermaker.com/grint-ti:e_n-cut
COPYRIGHT JENNIFERMAKER®

Step 4: Select your Cricut
(if necessary) then click
Send to Printer.

Step 7: Place your printed
page on your cutting mat,
load it, and click Go.

@ Pred

(®) Gustom metea st Printable Vinyt

@ Loxoos and mat

Select the image on the
right and click Continue.

PRINT THEN CUT
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HOW TO
UPLOAD IMAGES ON A MAC

as Untitled

Step 3:

Click Browse Drag & drop file here

or

Cut your images for free (basic and vector).

Browse

Images can be jpg, g. .bmp, .svg, or .dx( files

Step 4: Select .png, .jpg, .gif, .svg, .dxf, .omp
a PNG, JPG,
GIF, or BMP and
Recently uploaded image Cl'ick Open

B 4 Qsearcn |

Favorites Date Modified

Recents. Today at 2:29 PM
M

[ Documents
Step 1: o ¢ .
Click Upload ; e e
Click Upload @ gmovors I N T

@ Creative Clou... @ rainbow..cartpng ©  Sep s, 2018 at 843 AV

Image 5 Aok

B3 cuT ABOVE

Options

Step 5: Choose an Image Type (I recommend Step 6: Clean up and refine your image using the
Complex, but you can test) and click Continue. tools, if you wish, then click Continue.

i®

Upload Image Selectfinage type
Upload an image from your computer Your image il be Moaded as  singl layer
(png, Jpg. .gi, svg, xf, or omp) age. Select & erase

Simple
High-contrast colors and transparent or
background.

Moderately complex

‘Simple details and color, with good contrast between
‘and background.

Giick on the areas of the mage you
want o amon.

Use advanced options below for
adaionalcontrols.

Replace Image
= Complex

1o [ 3 8 {m [
io {2 3 B {m {0

Fine detal, blended colors, or low contrast betweafu
‘and background. This ima challenging
with,

Step 7: Choose Print Then Cut or Cut Image, type
a name, and click Continue.

UPLOAD IMAGES (MAC)

HON |l

Select Upload Type Image Name

rainbow-heart

Tags (optiona))

Image Pattern fill

Enter keywords separated by a
Upload an image to use in designs. Upload a patter or photo to use as a il in designs.

pativl file types: jpg. .gif, png, .omp, v, or cxf Compatible file types: Jpg, gi, pg, .omp

Recent Uloads View All

o {o B ju {9
0 e iRz {2 e

[==]
s

Practice this at https://jennifermaker.com/rainbow-heart
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HOW TO
UPLOAD IMAGES ON A PC

16 1o 04 1 43 |2 15

Untitled

Step 3:
® & Click Browse

1

7

Templates

Drag & drop file here

or

Browse

Cut your images for free (basic and vector).
Images can be jpg, .gif, png, .bmp, .svg, or dxf fles

Step 4: Select .png, .jpg, -gif, .svg, .dxf, .omp
a PNG, JPG,
GIF, or BMP and
Recently uploaded imagg Cl'ick Open

Step 1:
Click Upload Click Upload
Image

Step 5: Choose an Image Type (I recommend Complex, Step 6: Clean up and refine your image using the
but you can experiment) and click Continue. tools, if you wish, then click Continue.

P At

i®

Upload Image Selectfinage type
Upload an image from your computer Your image il be Moaded as  singl layer
(Png, Jpg. it svg, ., or bmp)

Simple
High-contrast colors and transparent or
background.

Moderately complex

‘Simple details and color, with good contrast between
‘and background.

Select & erase

Giick on the areas of the mage you
want o amon.

Use advanced options below for
adaionalcontrols.

UPLOAD IMAGES (PC)

Replace Image
= Complex

<
A
=
Z
&
il
2

1o [ 3 8 {m [

Fine detal, blended colors, or low contrast betweafu
‘and background. This ima challenging
with,

Step 7: Choose Print Then Cut or Cut Image, type
a name, and click Continue.

HON |l

Select Upload Type Image Name Upload

rainbow-heart

Tags (optional)
Image Pattern fill

Upload an image to use in designs. Upioad a patter or photo o use as a il in designs.
€ mpatible file types: Jpg, gif, png, bmp, .svg, or xi Gompatible il types: Jpg, gi, png, .omp

Entor keywords separated by a

Recent USloads  view an
-

HERE I I {3 - (=]
e {o m {8 {2 {9 o[

8000000000

26 Gutimage & PrintThen Cut image
@

Practice this at https://jennifermaker.com/rainbow-heart
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HOW TO ERASE A

BACKGROUND FROM AN IMAGE

Step 1: Find or upload a JPG, PNG, GIF, or BMP
file that you want to use. When asked for Image
Type, choose Complex and click Continue.

Upload Image

Upload an image from your computor

(png, .ipg, g, svg, Gxf, or bmp)

for, with good contrast between subject

o i® 3 8 ju {2 o [l

Step 3: Click on the white background around
your image to erase it. You may need to click in
several areas to get it all.

ron

Select & erase

=
a
g us
z
z
=
=

Step 5: Decide if you want to save it as a Print
Then Cut, or just a Cut Image, then click Save.

Select Upload Type Image Name

_— rainbow-heart

Tags

fe {e 3 {8 {m {0 o [

0 e 3 B = {3 e I

Step 4: Click Preview to see the cut lines of
the object remaining. If it looks good, click
Continue.

ron

Select & erase

Tapiaes ik on the areas of the mage you

[SEEION I

{0 {» 3 {0 iz

Step 6: Once saved, you can use the image by
selecting it and clicking Insert Image.

7

Image Pattern fill
Upload an image to uss in designs. Upload a pattem or photo to use as.a fil in designs.

Qinpatie fle types: jpg, .gi, png, .omp, sv, or .t ‘Compatible file types: Jpg, -gi, png, .bmp

o io 3 I8 {m {2 @ [l

@#fCont Uploads

Practice this at https://jennifermaker.com/rainbow-heart
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HOW TO
COMBINE MULTIPLE PROJECTS

While there is no built-in function in Design Space that allows you to combine projects, there is a simple

workaround. Here’s how you do it:

Step 1: Open the project you want to
add to another, select all layers, click
Edit, and select Copy.

||~ Butterfly Garland
W mscon

~ Butterfly Garland
|

~ Butterfly Garland
W Bascom

~ Butterfly Garland
W ssecn

~ Butterfy Garland

{o fo 3 i {u {2 e [

Step 3: Locate and open the project you want to
combine your first project with.

- Dowhat youlove

M\ Basicout

~ Slice Result
77\ BasioCut

~ Slice Result
M\ BasicCut

~ Slice Result

ie fo =3 iR {o {9 o [l

Your layers from the first project appear on the
canvas with the second project!

Step 2: Go to the File menu at the very top of
your screen and select New Window.

Edit View Help

fe i® =3 {8 {m g o [

fe {® 2 I8 o {3 o [l

ﬂ ~ Text- Cricut Alphabet
D seecu

~ Growp

- Slice Rosult

- Dowhat youlove .=

M\ BasicOut
~ Slico Rosult

7\ Basiccu
~ Slico Rosult

M\ BasicOut
~ Slico Rosult

M\ Basicoun

w0567 ¢ W 4379 Qo L

B T e
youlove .

l’ w ==

Practice this at https://jennifermaker.com/butterflies and https://jennifermaker.com/rainbow-love
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HOW TO UPLOAD
SVG FILES ON A MAC

Canvas Untitied* Step 3 0

Click Browse
Drag & drop file here

or

i i®

_‘
8

()
A Step 4: png, ipa, 0, svg, ., or bmp
Image Select' the
Upload an image to use in designs. SVG Fl le and
Compatible file types: .jpg, .gif, .png, .bmp, .svg, ol C l'ick 0 pen

UPLOAD SVG FILES (MAC)

) R B
Favorites

E Recents

3 Documents

Recent Uploads  viewan & icloud Dive

/A Applications
Step 1: Step 2: i
Click Upload Click Upload Image o

Options.

9 =3 {F im

H

e f» 3 |y {im {9 1©

My Projects.

Prepare to Upload Image name NOteS:
S p—— Be sure you select the SVG file,

S— not the ZIP file. You can tell it is

oot the SVG file because its “Kind” is
listed as “Scalable Vector Graphics
Image” in your file browser. If you
only see the ZIP file, you’ll need
to first decompress the ZIP file
(open it) by double-clicking it in
your Finder.

=
s
=
7z
4
b3
=

5§ Cutimage

Replace Image
Each color in this image will be an individual cut layer.

Step 5:
Click Upload

Upload

Step 6:
To use your SVG, select the image you just uploaded then
click Insert Images

Image
Uplosd snimage o se i esins.
Campatie e types: 1o, 9t, g e, vg, o

Recent Uploads  vieway

ie o =g o |2 © [l

Practice this at https://jennifermaker.com/svg-heart
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HOW TO UPLOAD
SVG FILES ON A PC

Step 3:

® Click Browse
Upload Drag & drop file here

16 1o 04 1 43 |2 15

ar

Brawse

'A Step 4: SeleCt .png, .jpg, .gif, .svg, .dxf, or bmp
the SVG File

{3 1@

Image
Upload an image to use in designs.

Compatible file types: .jpg, .gif, .png, .omp, .svg, ol

© 13 [ fo

Recent Uploads  view au

Step 1: Step 2:
Click Upload Click Upload Image

£

Prepare to Upload Image name

heart-jennifermaker-SVG

Be sure you select the SVG file,

S not the ZIP file. You can tell it is

g the SVG file because its “Type” is
listed as “SVG Document” in your

‘ ) file browser (it may say “Chrome

HTML” or “Edge HTML” instead).

If you only see the ZIP file, you’ll

need to first decompress the ZIP

file (open it) by double-clicking it in

Windows Explorer.

£
5.:'5.
-
Z
:
L
=

Replace Image.

Each color in this image will be an individual cut layer.

Step 5:
= Click Upload

Upload

Step 6:
To use your SVG, select the image you just uploaded then
click Insert Images

Pattern fill
%0 a pattorm or afilin designs.
uuuuuuuuuu types: Jpg. i, pg, bmp.

fe {» =3 {8 {w {3 © [

fe {o i (@ {2 e [

@ =

Practice this at https://jennifermaker.com/svg-heart
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HOW TO
RESIZE A PROJECT

Have you ever uploaded an SVG design, cut it out, and realized it was too small or too big? Here’s how to
check the size before you cut, and how to resize an entire project.

15 1o 02 @ {3 {2

Step 1: Insert, upload, or create an image on Step 2: Note the size at the top of the window (it also
your canvas in Design Space, click Select All. appears above and to the right of the selection itself.)

e {e 3 (8 (w3 o[l
e {e 3 (8w {2 o[l

w

Size
w 10567 # H

To determine if the sizing is right, compare it to the sizing in the original instructions or tutorial. If no sizing
is provided, you’ll have to use your best judgment. Here’s how to resize a project:

Step 3: Be sure the lock icon LOCKED & The entire selected image(s) is resized and
indicates it is locked, then type [NNE—_— retains its proportions.

the proper size in either the W or

H field at the top of the screen.

e e 3 (8 iz {3 @ [

o}

Size @ Size

w(s 4 4 2072 4 w(s n

=

o {o =3 {8 {m {3 o |
RESIZE A PROJECT

6

You can also resize images using the resize icon Note that Cricut Design Space may automatically resize

in the lower right corner of a selection box. any SVG file that measures over 23.5" (either wide or

Just click, hold, and drag to resize. high) down to 23.5" on its longest side, and there is no
notification that an image was resized. So if you ever
place an image on your canvas and notice that one side
measures exactly 23.5”, that is a strong indicator that
your image has been resized.

Practice this at https://jennifermaker.com/butterflies

PAGE 40 ¥V COPYRIGHT JENNIFERMAKER®



http://jennifermaker.com/butterflies

CRICUT® COACH PLAYBOOK

16 1o 04 1 43 |2 15

HOW TO USE AND MODIFY

CUSTOM MATERIALS SETTINGS

You can use and modify settings for MANY materials using the Custom Materials settings in Design Space.

Here’s how you access and change them:

Step 1: Click the icon with three lines
in the upper left corner and select
Manage Custom Materials.

~ Butterfly Garland
W weou
- Butrty Garand
Dy seiocu
« Buttrty Garnd
W Basicout
~ Butterfly Garland
W oiccu
~ Butterfly Garland
, > owcon
Gourtn:Unto st
o

Sign out

T T p—"

Step 3: Scroll through the list of materials, find

one you want to edit, and click the Edit button
next to it.

Custom materials

Maker : 4392 Bluetooth [
Custom Materials

Material Name: Cut Pressure: Multi-cut: Blade Type:
110 b. Cardstock 300 2x Fine-Point Blade

Acetate Fine-Point Blade

Adnesive Foll Fine-Point Blade

Adnesive Foll, Matte Fine-Point Blade

Adhesive Sheet, Double-
sided

Fine-Point Blade

Step 5: If you want to create an entirely new
custom material, click Add New Material, enter
settings, and click Save. Then click Done. You
may need to experiment to get it just right.

Rotary Blade

Uttra FirriSstabliizer Rotary Blade

Vellum Fine-Point Blade

Velour Rotary Blade

Velvet Ug Rotary Blade

Velvetee Rotary Blade

Vinyl Fine-Point Blade

Viscose Rotary Blade

Volle Rotary Blade

Watfle Cf Rotary Blade

Washi st Fine-Point Blade

Wax Pap) Fine-Point Blade

Window Fine-Point Blade

Wool Crg

Wrapp!
Ziberling

Rotary Blade
Fine-Point Blade

2228282228888 ¢8¢8¢¢

Rotary Blade

Step 2: If prompted, select your Cricut and
click Done. Give it some time to load your
settings.

Select Gricut device -

Maker : 4392 Bluetooth
Air2:113USB

Step 4: Change your settings as needed.
Usually, | just increase the pressure with the
slider. When done, click Save.

Custom materials

Maker : 4392 Bluetooth
Custom Materials
Material Name: Cut Pressure: Mult-cut: Blade Type:
110 1b. Gardstock & B 5 Fine-PontBiade ¢
300
®.
@

TS T

Fine-Point Blade

Acetate

Step 6: Explore One, Air, and Air 2 machine
owners must set their dial to Custom (Joy,
Explore 3, and Makers are on Custom by
default), and then you can choose your custom
material before you cut out your project.

Ar2:113UsB.

0 Set material

<1+~ material below or adjust dial
s Popular Browse All Materials.
Leather
Light Patterned Window Cling ~ Faux Leather
Paper

Vinyl (Paper Thin)
¢ ¢

Iron-on

Paper
¢

Plastic Fab

ble Ink Construction Vellum Foil Acetate. Magnetic Sheet - Canvas.
fer Sheet  Paper
¢

Haojsp ey WM

Bonded Fabii®

PAGE 41 ¥V COPYRIGHT JENNIFERMAKER®

CUSTOM MATERIALS




CRICUT® COACH PLAYBOOK .8

HOW TO GET '"
NEW UPDATES ON MAC

Cricut Design Space updates often and changes are rolled out to Tip: To check the version, click the
groups of users in phases rather than all at once to make sure Design Space icon in the Applications
the updates go smoothly. Updates may happen automatically folder, then press Command + |
upon launching the app, or if the app is open when the update is

detected, you will be prompted to update your application—if this e et
happens, save your work and accept the update. . * f e

Cricut Design Space  338.3MB
Modified: May 6, 2021at 5:07 PM

If you are ever unsure if you have the latest version of the app, go il command § =
to the Release Notes at jennifermaker.com/cricut-release-notes, . e
check the latest version, and compare it to yours. Here’s how you L

can download the latest version of the Cricut app: e

Lock:

¥ More Infor
Last openod: May 13, 2021 at 4:23 PM

Step 1: Download the installer at Step 2: Open the downloaded Step 3: Click Replace when

design.cricut.com file and drag (click, hold, & move) you are asked if you want to
the Cricut icon over the folder, replace it with the one you are
then let go of the mouse. moving.

& Finder File Edit VI L Window Help & Finder File Edit View' Go Window Help

sign Space Install

cricut. 77, S

ation. Do you want to replaco it wi
ing?
Keep Both stop.

Design Space®

Setup a new Cricut product, browse projects, stat designing,

—=—)| Cricut Design Space Applications.

To see what new features are available to you, go to the menu in the upper left and choose What’s New
or go to jennifermaker.com/cricut-release-notes.

@ Cricut Design Space File Edit View Help @ Cricut Design Space File Edit View Help
[ XoN ] Cricut Design Spac 00 Cricut Design Space v6.8.143

"n‘ JenniferMaker Heart Slice by JenniferMaker
» View Profile o / Whatls NeW

UPDATE APP (MAC)

Home 4 New in 6.8

Improved security

Canvas Your privacy is paramount. With our new sign-in experience, we're making sure you get industry-leading

security as well as the convenience of fewer sign-ins to Cricut apps.

New Product Setup .
New in 6.7
Calibration

4 New Insert Card Sizes
Manage Custom Materials
Just for you, Goldilocks. Find designs that are "just right" for your card size with at-a-glance badges,

Update Firmware required size selection, and clickable search links for Cricut Joy.

Account Details
Link Cartridges New in 6.6
Cricut Access Project Collections

) Easily organize your projects into custom Collections, so you can quickly find what you want, when you
Settings want it. Create up to 5 unique titles. Or with a Cricut Access plan, create as many as you need.

Offset

Make your designs pop with a new layer that replicates a shape, text, or group of objects. Offset is available

I BNited States on Windows 10 (64-bit) and macOS 10.13 and later.

NI A
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Desktop

HOW TO GET
NEW UPDATES ON PC

Cricut Design Space updates often and changes are rolled out to
groups of users in phases rather than all at once to make sure

the updates go smoothly. Updates may happen automatically
upon launching the app, or if the app is open when the update is
detected, you will be prompted to update your application—if this
happens, save your work and accept the update.

Tip: To check the version, hover
over the Design Space icon in the
Taskbar when it’s running.

‘ Cricut Design Space v6.10.107

Crcut USsign Space ...

If you are ever unsure if you have the latest version of the app, go
to the Release Notes at jennifermaker.com/cricut-release-notes,
check the latest version, and compare it to yours. Here’s how you
can download the latest version of the Cricut app:

Step 1: Download the installer at

design.cricut.com

Step 2: Open the downloaded
file to install it and give it time
to install. It is fine to replace

Step 3: Open the update Design
Space. You will not lose access
to any of your images or fonts.

it if you are asked.

cricut

cricut.

for Windows® 68143

cricut

Design Space® for Windows®

r Windows®
=

Starting Design Space

UPDATE APP (PC)

To see what new features are available to you, go to the menu in the upper left and choose What’s New
or go to jennifermaker.com/cricut-release-notes.

\ - JenniferMaker
. » View Profile

Home ‘ New in 6.8

Heart Slice by JenniferMaker

What's New

Improved security

Your privacy is paramount. With our new sign-in experience, we're making sure you get industry-leading
security as well as the convenience of fewer sign-ins to Cricut apps.

Canvas

New Product Setup .
New in 6.7
Calibration

X New Insert Card Sizes
Manage Custom Materials
Just for you, Goldilocks. Find designs that are "just right" for your card size with at-a-glance badges,

Update Firmware required size selection, and clickable search links for Cricut Joy.

Account Details

Link Cartridges New in 6.6

Project Collections

Easlly organize your projects into custom Collections, so you can quickly find what you want, when you
want it. Create up to 5 unique titles. Or with a Cricut Access plan, create as many as you need.

Cricut Access

Settings

Offset
Make your designs pop with a new layer that replicates a shape, text, or group of objects. Offset s available

V- Unhited States on Windows 10 (64-bit) and macOS 10.13 and later.

NI A
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HOW TO TROUBLESHOOT
DESIGN SPACE PROBLEMS

Your ability and willingness to troubleshoot problems is a high factor in your success with your Cricut (and

really, most things in life). Problems happen, but you CAN solve them. Here are the steps | take when |

encounter problems with Cricut Design Space:

Cricut Design Space is acting weird or not working at all.

Is it down? Check https://status.cricut.com

Watch the status site for it to come back. Yes No

Still having problems? Is it installed and up-to-date?

Yes Restart your computer. Yes No

Are you still having problems?

Have fun and make
something awesome!

Do you have a strong Internet connection? Yes No

Keep the Design Sp’ace Yes No Connect to Internet &
app active and don’t move your Cricut and
move away while cutting. computer closer to router.

Are you still having problems? Still having problems?

Close any other applications running

Yes No
on your computer.

No =

Are you still having problems?

Make sure your Cricut is actually Yes No

connected via USB or Bluetooth.
Are you still having problems?

Disconnect your Cricut, restart your

. Yes
computer, and reconnect your Cricut.

Are you still having problems?

Yes No

Having different problems?
Here are more solutions:

Machine problems:
Check the Cricut site at

https://help.cricut.com

Cutting problems:

Check my ideas at
https://jennifermaker.com/
cutting-problems

Mat problems:

Check my mat tips at
https://jennifermaker.com/
mat-tips

Blade problems:

Check my blade tips at
https://jennifermaker.com/
blade-tips

Contact Cricut Member Care at https://help.cricut.com. | recommend the Chat option when available—
you can also call during open hours or email them at anytime. Cricut Member Care is very helpful!

PAGE 44 <V COPYRIGHT JENNIFERMAKER®
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Step 1: Connect
your iPhone

or iPad to the
Internet through
WiFi or Cellular
Data and tap the
App Store icon on
your iPhone or
iPad.

Step 3: Tap
Download to
download and
install Cricut
Design Space.

If you already
have Cricut
Design Space
installed, you’ll
see a blue Open
button to tap.

CRICUT® COACH PLAYBOOK

*B00

Messages Calendar Photos Camera

i \
«tv . G
Maps Weather Wallet

® 19'12‘2
. diy

5 5
® 7.5

\/J\/L\/

Reminders Clock Stocks

pm——

FaceTime

< Search

Cricut Design Space
Cricut, Inc.

246K RATINGS AGE

4.8 4+ #7

% % %k Kk Years Old Graphics & Design

What's New

Version 4.14.5 3w ago

Version History

- Fixed crash with saving projects
- Added additional language support in Project
Details more

Preview

Make It Now Projects Design S
Eoit your images and tetusing {

® e Fall Framd

Step 2: Tap
the Search
icon and type

in Cricut, then

tap Cricut
Design Space.

Step 4: If
prompted,
sign in with
your Cricut
account email

and password.

Note: If this
is your first
time using
Design
Space,
click here
to create

a free
account.

HOW TO INSTALL
CRICUT DESIGN SPACE

3:07 PM

U

cricut design space
cricut app
cricut access
cricut basics

icut craft room
cricugdesign
cricut expijre air
cricut maker

monograms for cric

7 29%@ )

Cancel

Cricut

Design Space”

Machine Setup

Q Sign In
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CRICUT® COACH PLAYBOOK

HOW TO OPEN AND START

Step 1: Tap the
Cricut Design icon
on your device.

Tip: If this is your
first time using
Cricut on your
device, you’ll
need to install

it first. See page
45 for directions
on how to install
Cricut Design Space
on your iPhone or
iPad.

Step 3: If

you see this
message, it
means you left
something on
your canvas the
last time you
used the app.
So either tap
Keep Previous
(if you want to
see what you
left there) or
tap Replace for
a new, blank
canvas.

ull AT&T 12:37 P

A NEW PROJECT

Wil AT&T LTE 11:06 AM 7 % @)

7 3 (-

Step 2: Sign in

and tap
the New
Project button

Wednesday

Calendar Photos

D !N @

[VET S Weather

v
amn ~

®

@

Notes Reminders

Note: If you
see an empty
circle in the
upper left
corner, that
means you’re
not signed in.
Tap the circle

to sign in! Do whait you love

8
all ATST 2 A

Q View |
Sign In

Note: If you don’t see any of your saved projects,
it may be because you’re not signed in. You can
get signed out when you update your app, too!

New Project Rainbow

e Share

iTunes Store News Health
T —
) e

Settings FaceTime

f

App Store Facebook
Do What You Love Rai...

@ Share ©oo0

Do What You Love Rai...

@ Share 000

® 0 00000
-260

WX

. il AT&T LTE 11:06 AM 73 @
You will

get a new

I3

= Untitled [:.:]
o | ! | Mz ! 18

=)

canvas, ready
for you to
add images,
shapes, text,
i !
Project Already Exists and projects!

A project already exists on the canvas.
Do you wish to keep your previous
project or replace it with the new
project?

Replace

Keep Previous

BA Y es XN

Actions Edit Sync
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CRICUT® COACH PLAYBOOK

HOW TO CONNECT IOS TO
CRICUT VIA BLUETOOTH

Step 1 . Tap the il AT&T wmmu 7 3 (- Step 2: Tap all AT&T LTE 11:11 AM 7% @)
Settings app. . & l O l Bluetooth.

.
Messages Calendar Photos Camera Settlngs

= (N e
Cricut Design TV Maps Weather Jennifer Marx
AT 3 Apple ID, iCloud, iTunes & App Store
{

2
®
sn/ 2:
® LS, o4 .
- iPhone Not Backed Up o

Reminders Clock

o Airplane Mode

Health
Wi-Fi

PN
L]l
FaceTime

W Cellular

Personal Hotspot

Facebook

M | Notifications

Control Center

Note: Your Cricut must be within 10-15 feet
of your device. If you need to use a Wireless
Bluetooth Adapter, make sure it is inserted.

Wl ATET LTE 1:11AM b all ATRT LTE 12:50 PM

Step 3: Turn .  settings Bluetooth Step 4: I.f you -
on Bluetooth if get a pairing
it is off, then request, type
look for Cricut Bluetooth 0000 (that’s
in this Iist and Now discoverable as “Jennifer's iPhone”. four zeros) as coed
tap it. If you do MY DEVICES the passcode

not see it liSted’ 27" iMac Retina Not Connected @ and tap Pair.

make sure your
Cricut is turned
on and no Not Connected (D)
Oth?r B!uetooth JLab Neon BT Not Connected @
device is
connecting to it.

CricutAIR2-27EQ

CarAccessorySystem Not Connected @

Maker-4392 Not Connected (D) Once connected
b

Vivitar HP Not Connected (D) you can go to
the Cricut Design
Space app and
send projects

, - to your Cricut
To pair an Apple Watch with your iPhone, go to the .
Watch app. machine.

CONNECT VIA BLUETOOTH

iHome iBT84m Not Connected ()

OTHER DEVICES
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CRICUT® COACH PLAYBOOK

HOW TO FIX MISSING OPTIONS
(REINSTALL THE 10S APP)

Is your Shapes button grayed out in your Cricut Design Space app? Does something just not seem right? If
so, you may need to delete and reinstall the app to get things back to working order. Here’s how to do it:

il ATET B 1:30 PM 7 28%05 ) AT S SR P = T3TPM PR

The @ [¥) Do What You Love Rainbow * ([l ) Step 1: Q Step 2: Settings
T e [ BT R E e e

Shapes Make —— Go to
button sure all iy Pt inthe e your B cenea
is grayed of your " e oo Cantr
out and E A projects My Favortes screen, Display & Brightness
cannot 1 are saved |- [ tap

be to the Al Categories Eiew Settings,
tapped. | Cloud, 8 o then tap
: not just S General.

Accessories

yo u r Anna Griffin @ Banery
iPhone f& prvacy

or iPad.

Do what youlove

Accessibility
Wallpaper

siri & Search

U[lj Touch ID & Passcode

ED Eemergency sos

Cards
iTunes & App Store
Christmas
B walet & Apple Pay
Clothing

Col
1 Make It oneg n Passwords & Accounts

I ATRT = 1:32PM 7 29%E ) antl ATaT 2 1:32 M 7 30%ED i ATRT = 1:33PM 7 30% )
Step 3 . { Settings General Step 4: < General iPhone Storage < Back Cricut Design
s - s messages w e oo U
Tap Locate
RECOMMENDATIONS SHOW ALL
. About Cricut Desi
iPhone the . ¢ i
Software Update . Provo Crat & Novelty
Storage CrlCUt Save 125.57 GB - Automatically upload and safely
- . store all your photos and videos in iCloud o you can
or ]Pad Des]gn browse, search, and share from any of your devices
AirDrop
Storage app and
? Handoff

tap it
based ol CarPlay p = Save 3.03 GB - Automatically offload unused apps OfficadiApp

WhiCh when you're low on storage. Your documents & data — e
will be saved. and data. Re lligg the app will place back your data if the app

is still available’ App Store.
d eVi ce ‘me Button

App Size

Offload Unused Apps Enable

Photos Delete App

you Last Used: 10/17/19 8457 GB

iPhone Storage This will delete the app and all related data from this iPhone. This

i L e
have. Audible .

Background App Refresh Lost Used: 1071418

c:icut Design 178 GB

ast Used: today

Date & Time
{7 Garagesand —_—
4 Last Used: 6/16/17 :

Keyboard

Step 6: Step 7: N Step 8: ‘15.;“”;5"“’ e mm
Do a hard reset (force restart) Tap the Crieut Design Space Tap open [ SRR R AR R
of your iPad or iPhone. This is App Cricut :
NOT the same as turning your Store @ u Design
device on and off. How you icon, o s e Space
do a hard reset depends on search ' AT DA and your
your iPhone or iPad model. Get for missing

Version History

directions on Google or at Cricut voffon a5 awago options
jennifermaker.com/hardresetiphone Design R aiion o soport i rfct will be
or Space, Details more baCk.

jennifermaker.com/hardresetipad and tap Preview
this icon. r——

FIX MISSING OPTIONS

Em@@%&}&

Image  Text Shapes Upload Actions Edit Make It
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CRICUT® COACH PLAYBOOK

HOW TO ATTACH
TO KEEP THINGS TOGETHER

Did you tap Make It and find all of your elements re-ordered and out of place? Fix this and keep
everything exactly where you want with the ATTACH button. Use Attach to hold your cuts in the same
position relative to each other on the cutting mat. The Attach feature also helps you affix a write or
score layer to a cut layer.

< Safari i T 4:57 PM 9 100% ©a) < safari i B 4:58 PM + 100% €42
Step 1: Add all Of ET] | Love Cricut Card (Simple He... CI] Step 2: Tap and drag @E} | Love Cricut Card (Simple He... (:Ij
your elements to ‘ a selection box around [ EEEEENANE F SO
the Cricut Design all of the images
Space app on | you want to attach
your iOS device, : together, tap on
including text, | Actions at the bottom
SVG designs, . of the screen, then
score lines, write | tap Attach.

lines, etc. :

Note that attached
layers will take on the
same color. So only
attach layers that you
really want to be the
same color!

| Tip: If you are having a problem attaching
& H AT S QA e layers, try ungrouping layers first.

pload Actions  Edit  Sync Llayers Undo Redo| Makelt

You can verify that your images are Score lines must be attached with the
attached by tapping and noting that appropriate cut layer in order for them to
they are now labeled “Attached Set.” score on the right layer, as shown below.

ATTACH THINGS TOGETHER

= 7 oo ____
(bl = dec il 100x <safari, | = 459 PM - 100% )

@) 1Love cricut card (simple He... (i) & 1Love Cricut Card (simple He... ( JI])

T
Layers @

Layers @ {5

v Attached Set . v Heart
B ¥ o
I ' cut = v Text - Cricut Sans

v Text - Cricut Sans - C ot

Co : v Text - Cricut Sans
B v fext - Cricut Sans = u | o
I I | oo E I I v Attached Set

v Square

] o«
® W
¥
Detach

RSN O TS YT

ol Ao Eit SN Make e oad  Actions Edt Sy Layers Undo Redo| Makelt

Practice this at https://jennifermaker.com/i-love-cricut
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CRICUT® COACH PLAYBOOK

HOW TO
GROUP AND UNGROUP

Grouping lets you keep objects together in your design but not necessarily on your mat (you still need to
use the Attach function to keep things together on the mat). Sometimes projects and uploaded images
will be grouped when you open/insert them, and you’ll need to ungroup them so you can make changes.

all ATET & 9:54 AM ¥ 56% @) all ATET & 9:54 AM ¥ 56% @)

Step 1: Tap Layers smieyface (D) Step 2: With all smisyrace (D
and select each T yes @ objects you want S AR RERN SN lyes @
Iayer you want to . €~ Sicedimage tobein a group s €~ Sicedimage
group together. v ‘ o o selected (layers turn 4 1 — o
Alternatively, you ~ v Heart gray when they are v Heart
can tap and drag a N/ Y- selected), tap Actions [ < /I A%
rectangle to select IR in the bottom toolbar SEE
objects. : I A then tap the Group | -
E N button. :
. Cut | . Cut
o w : o
4 (ﬁe EIE’LID 2 v Circle
® i

" A} Bv)

~ Growp Attach Weld B u Attach Weld

@%&%%ﬁ@ A &%%ﬁ@

es Upload Actions  Edit ~ Sync Layers Undq Makelt hapes. load Edit  Sync Layers Undq Makelt

v Circle

Tip: Once your objects group, they will be nested under a new line item in
your Layers panel called “Group.” - s

HOW TO UNGROUP:

Step 1: To ungroup, SR @M Step 2: Tap the layer Smiley Face * M
tap the Layers button S ECTERr | s @ titled Group in the B s @
in the bottom toolbar : ¢ Sedinage Layers panel to : o

and look for the word | [ g select it, then tap | || S |
Group. (Hint: There | ) the Actions button 1 |

may be more than NG and tap the Ungroup Ny e

one!) o © button. 5 © \

¥ Heart

¥

v Circle

°-

v Circle

e
< a project or image set has multiple groups. So if you want to attach
\‘ ¢ and have an issue, look for ALL groups and ungroup them first.
H

/ COAC!

h || 4 You often need to ungroup before you can attach objects. Sometimes,

Practice this at https://jennifermaker.com/smiley-face

PAGE 50 ¥V COPYRIGHT JENNIFERMAKER®

GROUP / UNGROUP



http://jennifermaker.com/smiley-face

CRICUT® COACH PLAYBOOK

HOW TO WELD

Need to join elements to create a new image? Do it with the Weld tool! The Weld tool can simplify a
design, keep the letters of a word connected, and combine shapes to create new designs.

Step 1: Insert any images you Step 2: Tap and drag a selection box around all
want to weld onto your Canvas. of the images you want to weld together, tap on
Actions at the bottom of the screen, then tap Weld.

Wil ATET & + 100% €42

@ [*]  Colorful E utterflies by Jennife... m L—\b

| o m\*m\m L

Actions

Note: If you are |
trying to create - - Tip: You can select
a single image | items within groups
with Weld, to weld by tapping
make sure all : on their names in
elements are | the Layers panel.
overlapping. |

B (= Q
B ~ Group Attach
+ i
@EE@%&JG &EE%JG
Image Text Shapes  Upload Actions Edit Make It Image Text Shapes  Uploadiy Actions Edit Make It

Once your images weld, they will Note: You can unweld ONLY if it is the current
change to the same color and a new project on your Canvas and you recently welded it.
image appears in the Layers panel. If so, tap Undo until you unweld the image(s).

ol ATRT T 4:48 PM ¥ 100% €3

<« Safari o 1| T 4:43 PM 7100% €43
@ =] Colorful Butterflies by Jennife.. C.:] @ [2) Colo! ul Butterfiies by Jennife... m %
o

TN TN O SN =
‘n [2 — cn BB Beoncn Bocorond Boconond nanaod
: Layers @

v Welded Image | |
- ﬁ W

w

s B R_RP O B O
t  Syc  Layely Und

o giRedo Camera Settings | Makelt

Practice this at https://jennifermaker.com/butterflies
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Step 1:
Insert your
images onto
your Canvas
so that
they are

overlapping.

Step 4:
Tap
Actions,
then tap
Slice.

(2
= |

. v

/ coAcHg

CRICUT® COACH PLAYBOOK

HOW TO SLICE
(CUT AN IMAGE OUT OF ANOTHER)

Want to cut out parts or even make your own custom designs? If so, Slice is the tool for you! Slice lets you
cut out parts of another object. If you keep slicing, you can make some pretty amazing designs!

4:09PM

Heart Slice

e VNG

Text  Shapes Upload Actions Edit

PR

Heart Slice *

Slice Tips:

After
you tap
Slice,
three
layers
called
“Sliced
Image”
will
appear
in your
Layers
panel.

< Safari | 5 4:10PM

@ (il Heart Slice [D
s I e Layers @

¥ Heart

¥

v Square

o=

a1 pM ¥ 99% 53

Heart Slice * m

Layers

v Sliced Image

v

v Sliced Image

(VR

v Sliced Image

] o

» You can slice both images and text.
 You can only Slice with two layers. If you have multiple images you want to Slice

out of another, use the Weld tool on the multiple images first.
« Layers in groups can be sliced if you select just the individual layers, not the entire

groups.

Step 3:
Select
the
layers
you want
to slice
(tap each
layer at
the same
time to
select
both).

Step 5:
Move,
hide, or
delete
the
layers
you

do not
want,
then
you're
good to
go!

2:10 PM

Heart Slice

Layers

v Heart

("

v Square

[] o

(o)
&

- Group Attach

& NS S

ihapes  Upload  Actior ns

< safari | T 411 PM

® o

Heart Slice *

o If you use Slice with hidden layers, all hidden layers will be removed.
o If text is multi-layered and one layer is hidden, you can use the Slice tool. However,
if you ungroup text from its shadow layer, it becomes an image and will no longer

work with the Slice tool unless the text is ungrouped to individual letters.

Edit  Syc Layers

Weld

7 99% 53

€}
®

Practice this at https://jennifermaker.com/heart-slice
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CRICUT® COACH PLAYBOOK

HOW TO REMOVE
PARTS WITH CONTOUR

Need to erase parts of an existing design? Don’t want that word or that circle, but can’t ungroup or hide
a layer? Use Contour to remove existing parts from projects.

ol AT&T LTE 1:07 PM 7 % =) ol AT&T LTE 1:07 PM < 3 =)
Step 1: Choose © o unitea~ () Step 2: Tap on the —
13 1o

Hide Contohow All Contours

an image with 1 elements you want
elements you’d N to remove. If you
like to remove E Po) want to remove
then tap Actions, all elements

then tap the Hide (contours), tap the
Contour tool in Hide Contours link.
the lower right
corner of the app
window.

Hide Contour ] Pinch To Zoom

=
< & I 1

1 Unflatten Duplicate Isolate Letiers Hide Contour

B e B e W | e

Image  Text  Shapes Upload ctions Text  Shapes  Upload Actions Make it

The Contour tool is a great way to modify pre-existing
designs to meet your personal needs!

/ cOAC"S
ol AT&T LTE 1:08 PM 7 3 @) Wl AT&T LTE 1:08 PM 7 3 @m)

Hide Conto@how All Contours

that appear darker i that your image

10 11 12 13 i3

Step 3: Elements - Step 4: Confirm ® o untteds (I
E} 9

are those that you’ll looks the way
keep. When your E you want it. If ) Po)
image looks the way you need to make
you want it to, click more changes,
the Hide Contour just click the

icon again in the Hide Contour tool
lower right hand again.

corner to return to

your canvas.

n Unflatten  Duplicate Isolate LeticRy Hide Contoury Duplicate

BRI Br e e 5N

Text Shapes Upload Actions Make it Image  Text Shapes Upload  Actions

Tip: Contour isn’t permanent so long as you don’t Weld your images! If you decide later you want a
Contoured image to go back the way it was, or simply edit it further, all the hidden parts are retained!

Practice this at https://jennifermaker.com/svg-heart
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Step 1: Tap the Text
tool and add some

text.

il AT&T LTE 5:54 PM < 3 -m)
@ [ Do What YoulL... (&
D T T T T 6 T T T T 2, T
(%] (o]

o ©

{ \

zixjclvibin|m &

space

Step 5: As you work,
rotate the letters to
match the curve of
the circle.

il ATRT LTE 5:58 PM 7 3 -

@© @ pownatvour. [
— ==

Tio

& S i
oac Ac Ul Maks

tions  Edit  Sync Layers iake it
\

NS
.,
X

/ COACH

CRICUT® COACH PLAYBOOK

HOW TO
CURVE TEXT

Step 2: Tap Shapes
then tap Circle.
Resize the circle to
match the curve you
want.

il ATET LTE

Step 6: Keep going
until all the text is
in position.

Step 3: Tap the text,
tap Actions, tap
Advanced, then tap
Ungroup to Letters.

Tl ) ungroup to Layers

Jl ) ungroup to Letters

Step 7: Check that
your curves look
smooth and your

\’E_oulo

Step 4: Move each
letter so it’s base
lines up with the
circle below.

il ATRT LTE 5:56 PM 7 3 -

@© @ pownatvour. [
= > 0

16 17 1 [0

Step 8: Delete the
circle and group all
letters so they are

words readable. easy to move around.

il ATRT LTE 6:03 PM 7 3 -

@© @ pownatvour. [

T A RO

all ATET LTE 6:01PM all ATET LTE 6:02 PM 7 3 -

@ [ Do What YoulL... @ [ Do What YoulL... (&
] B 8 i 5 2 To 11 54

m %
8 A

~\

e AR O B0 SN O B0

Layers  Undo  Redo Camera  Settings Make it ayers  Undo  Redo Camera  Settings

Tip: If you have difficulties moving the letters into
position, it may be because SmartGuides are turned
on. To turn them off, tap Settings in the bottom
toolbar and toggle off SmartGuides.

Practice this at https://jennifermaker.com/rainbow-love

Sync  layers Undo Redo Camera ', Settings Make It
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CRICUT® COACH PLAYBOOK

HOW TO ALIGN AND
DISTRIBUTE OBJECTS

all AT&T LTE

& o

2 vl: 73

Step 1: Add two or more
items to your canvas
that you want to align or
distribute evenly.

Step 2: Tap and drag a
selection box around
all items you want to
align and/or distribute.

a el
Al el

©

= [1mi]

Align  Distribute

s Undo Redo Make it

é'm-l\s\ UL E R ¥ B €1 T B B | | il sl

FIp sl w2l ol ol 8 7l 8l sl

all AT&T LTE 3:41PM

Step 3: Tap on the Edit ®= Step 4: All selected

Hearts *

ALIGN AND DISTRIBUTE

tool in the bottom
toolbar, tap Align, and
tap Align Center.

items are centered.
Now let’s space them
out evenly.

=, Aign Left

| 6 o0

E 4.5 15 = |

—al  HPosition V Position Align

ft NN | O
tion: Layers Undo  Redo

s Edit  Sync Make it

Distribute

Wl AT&T LTE 3:42PM

Step 5: Tap on the ® =

7 % -

vears* (] 2

il AT&T LTE 4:19 PM

& o

1z €] Ta

7 3 -

1 BjF

T8 52 T

Hearts *

5 16 7

Step 6: Note that all

Edit tool in the
bottom toolbar, tap
the Distribute tool,

B < A lgll B hol

the hearts are now in "

a perfect row with the
same spacing.

and choose Distribute
Vertically.

| oistribute Horizontally

15l 14l 13l 121wl 10l 9l 8l 7l el sl 4l 3l 2]

R B B e e |

B ® B e

Image  Text Shapes Upload ake it

Practice this at https://jennifermaker.com/five-hearts
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CRICUT® COACH PLAYBOOK

HOW TO CHANGE
LETTER SPACE

<« Safari ull T 10:10 AM ¥ 52% @ ) < Safari ull T 10:11 AM ¥ 52%@ )

Step 1: + @ ¥} Do What You Love Rainbow * Clj Step 2: SeleCt the @ [*] Do What You Love Rainbow * CI:]
Tap the T P F text, tap Edit, tap .
(0]

Text tool, Text o; Letter Space, and |

choose a °x | Bowlas youlove tap the minus sign . Dowhat youlove
font, and : e ° until the letters look ®

type something : better. -

onto the Canvas. E

Note how the

letters are spaced i

widely apart. Let’s 1 Letter Space
fix that.

LETTER SPACE

0.4

S Make It

wll ATET 5 10:23 AM v 51%@ ) oIl ATRT T 10:13 AM v 52%@ )

Step 3: The letter @) [ DoWhat You Love Rainbow * Step 4: Select just @) @ Dowhat YouLove Rainbow* ()
“w” isn’t close T PPV OO COWOON o ‘ the letter “w” then o o e i oo oo o |
enough to the “h” , W tap Edit, then tap ;

in the example H Position, and tap

here. Select ' the + symbol to move

the text layer, v it to the right. Now

tap Action, tap these words are

Advanced, then tap i e properly spaced.

Ungroup to Letters.
YV [E

L_II__I 810 : () woowoios [ Edit H Position
Actions B Advanced . ,

h Tip: When you are done
adjusting the letter space,
“I " select them all and tap Do Wha,t you love

5
\‘ g Group to keep them

COACH

together from now on. If
you tap Weld instead, it

will stick them together

permanently.

Practice this at https://jennifermaker.com/rainbow-love
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CRICUT® COACH PLAYBOOK

HOW TO WELD TEXT
AND KEEP LETTER CENTERS

Welding text can be a little tricky. Typically, you weld script fonts (which can have overlapping letters) so
words cut out as single units. Sometimes when you weld, the centers fill in—here’s how to fix that:

701PM

Step 1: Tap ol fen el Step 2: If you R NEEEC AN Step 3: Repeat step 2 until you
Text, type in [MU>IEREEr Nl cet a center PN can weld and the letter center
script text, ' filling in (like |8 does not fill in (you may have
change your [} the p here), Lkl " to get REALLY big), then resize
letter spacing | s tap Undo, back down to the right size.
so the letters || T then use E
overlap a bit | JEStste . the Resize
(see page . Effie handle to
56), select | & , . make your
all, then tap || 2 text MUCH
Actions > ' ‘ larger, then
Weld. Sl 2 tap Actions >

< Weld again.

Another thing that can happen with text is that letter centers (the interior white space) can disappear
when you cut them out. But you can connect the spaces and keep the centers! Here’s how to fix that:

IATAT S FaPM SRS < safari | B 7080M 715%0 < Safari | B 7.08PM 1%

F

Text, type : Shapes, ] and drag the
text, and L select a rectangle

look for y square, and [ over a

letters & il Unlock it | : letter with 7
numbers and Resize i | interior white ¢
with interior [ it so it forms [ space so it’s
white space | a rectangle connecting
(counters), about the | the space

like A, B, D, \ width of : inside to
O0,P,QR,a, | the letter’s : the space

o,d, e, g,0, B . e s 0 ) outside, like
p,qand0, 4, i& S B e A E=ReRE A this:

6, 8, and 9.

E B

Step 1: Tap @g @ Step 2: Tap @E! ZLenerCTnlerCnn?edionPra.u (]ju Step 3: Tap @E] Let(erCQnmr(fonnactionPra.“ []j

| 2 2 i

< safari | B 709PM TU6%E < safari | T 715%0 < Safari | B 711 PM RAC

Step 4: Select WCIRLCICIECLN Y LTSS Il Repeat steps CE Mw T
the word and | B Delete all "IN 2-5 for g
the rectangle, | layers except |8 @ all letters as & :
then tap 5 i the layer ] e needed.

Actions > : with the T
Slice. | word in it. - N Adore |

KEEP LETTER CENTERS

Practice this at https://jennifermaker.com/script-text and https://jennifermaker.com/adore-text
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CRICUT® COACH PLAYBOOK

HOW TO
KNOCKOUT TEXT

Knockouts are a popular decorative effect. It’s not currently possible to do them completely within
Design Space for iOS, but here is a workaround until the day that (hopefully) the offset feature is added:

7 13%0 AT B 153 AM 11 ATAT 1153 AM

LikaTE 3w
® o Beautiful Knockout* ()
o EE P

Step 1: Tap Step 2: Tap Step 3: Tap Beautl Knockaut

@ = Beautiful Knockout *
TR

Text, type
your main
word in a
bold chunky
font like
Cricut Sans
Bold. Unlock
it, resize it
to make it
taller, and
tap Actions >
Weld.

Step 4: Tap
Make It, tap
the Mat Icon
in the upper
left, make
sure Bleed
is toggled
on, then tap
the Mat Icon
again.

Step 7: Return
to Design
Space, tap
Cancel until
you’re back to
your Canvas,

HAVTRU,

] Mat1of 1

Beautiful Knockout

Project C¢

BEAUTIFUL.

Upload Image

Text again,
type an
accent word
in script font
(i.e., | Love
Glitter).
Adjust letters
as needed,
unlock it,
resize it, and
tap Actions >
Weld.

Step 5: Take
a screen shot
of the Print
screen, crop
it so you

see only the
knockout
text, and
save it to
your photos.

Step 8: Verify
that your
image has a
transparent
background,
and tap Next.

Printer

1 Copy

v Welded Image

e CutPrnt

¥ Welded Image

the main
word layer
and tap the
Eye icon to
hide it. Tap
the accent
word layer,
tap Edit,
tap the Fill
menu, and
tap Print.

Step 6: Go to
Safari, visit

tap Upload,
find your
image, tap
Transparency
to make it
transparent,
press & hold
the image,
and tap Add
to Photos.

Step 9: Insert
the knockout,
resize it to
match your
accent word,
unhide your
main word,

o Pt @

NI Layers, tap [ Laers

¥ Welded Image
weses Cut| Priot
v Welded Image

® o [

57 a 06
@

‘Optional: adjust transparancy threshold
10| (more transparency)

Preview Background: [

Vode Wode help?

Share: FaceBook | Imgur | Twitter
Tap & hold on picture to save to phone

W ATET & 12:32PM RAK I
&0 Beautiful Knockout *
]1 2 g [s

Fs

Then tap Cut
Image, type
in a name,
and tap Save.

tap Upload,
tap Select
from Photo
Library, tap
Recents, and
tap the image.

position the
knockout over

Take a Photo

Select from Photo Library

Browse Files

word, select
both layers,
Cancel and tap
Actions > Slice.

Open Uploaded Images

Step 10: Delete the three sliced layers (leaving the
main word layer), tap and drag the accent word inside
the empty space sliced out of the main word, with the
accent word selected tap Edit > Fill menu and change
it to No Fill, tap the color box to change the accent
word color if desired, and tap Make It!

KNOCKOUT TEXT (iOS)

Practice t])is at https://jennifermaker.com/beautiful-knockout
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Step 1: Open your
project and tap
the text you want
to change the font
for. You can either
tap the text itself
on the canvas, or
tap the text line in
the Layers panel.

Step 3: Tap the
Font Name menu
in the lower left
corner.

Your font changes!

CRICUT® COACH PLAYBOOK

HOW TO CHANGE THE
FONT FOR EXISTING TEXT

Untitled *

Step 2: Tap the

‘4
vlh

T O e Edit button at the
bottom.

L

Step 4: Choose a
new font from the
pop-up menu.

Cricut S... B =

_  FontName Alignment Size L

o
<
=

Sync  Layers Make It

You can always see

~ Cuttin' U...

what font is used in
a layer by tapping
the Layers panel
and then tapping
the information
button ( () ) — this
information is
provided even if
you weld the font.

R) (=) (72

A —

~  FontName Style  Alignment size L

& mn Ny e 0

Upload  Actions Edit Sync  Layers Make It

@ E] Untitled *

@& mfinYs
apes Upload  Actiond Edit Sync

Untitled *

Make It

it R

| Select Change Font
| Cricut System

I Q Search Fonts

N v
Dowinloaded, Has Writing Style, Single Layer

alt st

Single Layer

Curdsive [0/

Single Layer

CuttimUp

Multi Layer

Layers

1 Cuttin' Up - Holy Cow
Subscribed

Practice this at https://jennifermaker.com/cricut-rocks
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Step 1: Select (tap)
the layer you want
to change, like

the center of this
flower.

Step 3: Select (tap)
the color you want.
If you don’t see the
color you want,
you can choose any
custom color in the
color picker below
it. When done, tap

Apply.

CRICUT® COACH PLAYBOOK

HOW TO

< Safari ! T 9:33 PM 7 1M1%04)

@ [¥)  Sunflower by JenniferMaker CI]

S & I

Image  Text Shapes Upload Actions

< Safari il T

Cancel

Material Colors

Step 2: Tap Edit
then tap the circle
above the Linetype
option.

Your object changes
to the color you
selected!

CHANGE COLORS

< Safari ! T 9:33 PM 7 1M1%04)

@ [¥)  Sunflower by JenniferMaker CI]

; No Fill /)
?, Fill
B4

GRCRG)

Image  Text Shapes Upload Actiol

< Safari ! T 9:34 PM 7 1M1%04)

@ [¥)  Sunflower by JenniferMaker * CI]

cu @ NoFil ) 44 a 44

Linetype Fill Width Height R

gmg@@a&le

Image  Text Shapes Upload Actions Edit Make It

Note that you cannot set pattern fills in the iOS version of Cricut Design Space. If you need to set pattern
fills, use a desktop or laptop to access Cricut Design Space and see directions on page 21.

Practice this at https://jennifermaker.com/sunflower-colors
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CRICUT® COACH PLAYBOOK

HOW TO CHANGE

LINETYPE AND TOOLS

The Linetype menu lets you change the tool for a layer. Choices for the Joy are Cut (default) and Draw.
The Cricut Explore adds Score. The Cricut Maker adds Engrave, Deboss, Wave, and Perf. You will only see
the Maker linetype choices if you’ve set your machine to Maker. (Note: You cannot use the Knife or Foil
Transfer tools with the iOS app.) Here’s how to set your machine and change the linetype.

Step 1:

circle
menu in
the upper
left, tap
Machine
Selection,
then

tap your

v Cricut M

Tap the B _ crew Bl ramiy

Cricut.

< Safari il T

Tap Draw o
then

Apply

toseta o gamr i om

Point (0.3)

layer to
write with

. Dlack

Step 2:
Tap a
layer,
then tap
Edit,
then tap
Linetype.

Tap Score
then Apply
to set a layer
score with
the Stylus
(Maker or

1y Star by JenniferMaker * ()

Tap Cut then
Apply to

use the fine
point, deep
cut, fabric, or
rotary (Maker
only) blades.
You cannot
use the knife
blade with the
iOS version.

LINETYPE & TOOLS

Tap Engrave
then Apply
to set a layer
to use the
Engraving
Tool (Maker

pens and Explore) only).
markers. Bk i g or Scoring

You can . Wheel Tools
choose (Maker only).
the color e

an d Tawny (Infusible Ink)

thickness,
too.

Tap
Deboss
then
Apply to
set a layer
to use the
Debossing
Tool
(Maker
only).

Tap Wave
then Apply to
set a layer to
use the Wavy
Edge Tool
(Maker only).

Tap Perf
then Apply
to set a
layer to
use the
Perforation
Blade Tool
(Maker
only).

Practice this at https://jennifermaker.com/starry-star
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Step 1: Tap
Text,tap the
Filter icon,
and scroll
down to tap
Writing to
see writing
fonts.

Step 4: Tap
Linetype.

CRICUT® COACH PLAYBOOK

HOW TO SET TEXT TO
WRITE WITH A PEN

You can insert a Cricut pen or marker into any Cricut Explore or Maker machine and have it draw with it,
and many crafters like to use this feature with a writing font to mimic handwriting. Here’s how to choose
a good font that looks like handwriting and set it to Draw in Cricut Design Space:

11:18 AM 7 Q8 20%(05 )

Write On!

| Select Insert Font

& Q Search Fonts

Ot Shelch
ok s

1121 AM 7 Q0 25%(E5 )

Write On! * @M
G o T e v |

rite onl
® <

12

ize  Letter Space Line Spacel

& & K

¢ Shapes Upload Actions

oI ATET T 11:58 AM
= Meat 1 of 1

12" x 12" Material, Mirror Off
Draw.

Step 2:
Select a
writing
font
(such as
the free
Cricut
Sans or
Cricut
Alphabet).
Some may
have a
fee, like

this:

ol ATET B

Step 5: Cancel
Select

1118 AM

Write On! *

7 P824% 5

7 Q4 38%(H )

Apply

Draw and
tap a pen
type and
color.

B r

B coa

‘ Pink Crystal

Cactus Pink
B oange
B Adobe

B ornge Peel

Step 3:
Tap Edit,
tap Style,
then tap
Writing to
select the
Writing
style of
the font.

Step 6:
Adjust the
Font Size
and Letter
Space as
necessary
so it looks
the way
you want
it to look,
then click
Make It.

11:20 AM 7 Q8 20%(05 )

Write On! * @
G e T e v |

§ \V\rite onl,

Regular
Bold

Italic

Image  Text Shapes Upld®

ol ATET B

@& o
A

157 AM
Write On! *

Lo L T ]

a» Step 8: Insert the pen in your Cricut’s accessory
clamp, position your material on the cutting mat,
load your mat, and press the flashing button.

See my blog post at

https://jennifermaker.

com/cricut-writing for
more tips on writing

on your Cricut! | also
have a free writing font

Write ool

you can use at https://

jennifermaker.com/
writing-font

Practice this at https://jennifermaker.com/write-on
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CRICUT® COACH PLAYBOOK

HOW TO SCORE WITH A
STYLUS OR WHEEL

11| ATET B 314 PM il ATET & 3115 PM il ATET B

Step 1: @ EI Love Card* Step 2: Love Card* Step 3: @ B . @
Open or  cemesesssssmmssl 1P | e Change i wes ®
create a R and make [ i— lines to . M
project ' sure any ’ scores by T
with score [ lines to be | A tapping [ sk
lines. You @ scored are W ’ the Line 2 o
can add = identified layer,

a score i as A tapping

line to any i “Score” . Edit, then

project by @& next to it. & tapping

tapping If not, see |H Linetype.

Shapes, , step 3. If J
then' (o) (2 thgy are, | ISP
tapping Q1 === skip to o e
Line. S @ GRCR BN M step 4. RIS

Image  Tex Upload  Actions  Edit

il ATET B 315 PM 7 89% (1) wil AT&T (TE 7:53PM

Step 3a: Cancel Step 4: Make g Step 5: Mat 1 of 1
Tap the sure your score [t Make sure
menu at O reon line is attached the score
the top, to the layer you o= line is on
then tap i want scored (look the same
Score E for the words - ¥ layer as
in the “Attached Set” the cut,
Linetype i above the score then tap
menu, and base layers to confirm), Continue.
then tap then tap Make It. If they are
Apply. not attached, see page 49

for directions on how to at-

tach layers.

il ATET LTE 7:54 PM

- . ; ;
Step 6: Mat 1 of 1 Step 7: . _— Step 8: e

Check the ‘ Tap on the _ Insert L

necessary [ scoring ' the SCORING
tools. 8 ‘ tool of scoring §
If the - ‘ tool that
screen oo matches
says to (D) Material set: Medium Car... i o — step 7,
use a Fre b then
scoring @ oo press the
wheel Yo G flashing
but you oG icon on
do not v G your
have one, — e Cricut.
tap Edit T NG S

Tools.
Practice this at https://jennifermaker.com/love-card
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CRICUT® COACH PLAYBOOK

HOW TO REPOSITION ITEMS
ON MAT PREVIEW

Need exact control over where items on your mat are cut? Want to cut one mat with multiple pieces
of paper in different colors? You can do this if you reposition items on your mat before you cut! Here’s

how to do it on an iOS device (iPhone or iPad):

il AT&T LTE 8:54 PM

Step 1: Open or
create a project.
Make anything
you want to
appear on the
same mat the
same color. Tap
Make It.

\ o A

pload Actions Edit Sync Layers

il AT&T LTE 8:55 PM

Step 3: Move _
each object Met ot

on the mat by
tapping, holding,
and dragging to

a new position.
You can also
move and hide by

tapping the n

three dots.

12 x 12 mat, Mirror Off

Move to another mat

Hide Selected

SnapMat

Cancel

7 -

@ O rinkbuterties* ()17
o e

Continue

Step 2: Make
sure the items
you want to
reposition are
all on the same
mat.

Tip: You can
move objects
from one mat
to another by
tapping

the three B°°°
dots and
tapping Move to
another mat.

Step 4: Make

sure the material
on your actual
mat matches the
placement on this
virtual mat, then
tap Continue.

Practice this at https://jennifermaker.com/butterflies

ull AT&T LTE 8:55 PM

) Mat 1 of 1

12 x 12 mat, Mirror Off

SnapMat

all AT&T LTE 8:56 PM

7 Mat 1 of 1

12 x 12 mat, Mirror Off

SnapMat
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CRICUT® COACH PLAYBOOK

HOW TO MIRROR AND
CUT IRON-ON VINYL

Want to make a T-shirt or bag with iron-on vinyl? Here’s how to mirror your image and position your vinyl
on your mat for iron-on (heat transfer) vinyl!

< Safari il B 137 PM 7 37%8) < Safari il B 137 PM
Step 1: Smile @ Sl €D
Select all s g e O e
the ObjeCtS - ¥ Text - Cricut Font & Ba... N

7 36%8 1 138 PM

Step 3: Mat 1 of 1 an
Tap the
Mat icon

v Attached Set

8-

v Text - Cricut Font &...

you want
to iron-on,
tap Actions,
then tap
Attach.

S
Attach

Step 4:
Toggle
Mirror to
the on
position
and tap the
Mat icon
again to
close this
window.

Step 7:
Search

on “lron”
and select
the type

of iron-on
vinyl you
plan to use.

‘ ® ’ Mat 1 of 1
ile by JenniferMaker

Project Copies

. -

Material Size

Rearrange

Mirror (for iron-on)

il ATET UTE 10:34 AM 4 -

Close Al Malerials Favoriles

Search Results
Fueryzisy lron-(r
Fail o
Giltter Irer-Cny
Felograc o Sparkis IoneCn

Kaanlren-Or

PAGE 65

8-
8-

v Sliced Image

®-

<safariy | B 1:39 PM

Step 5: © Mt 1 of
Verify that
your image
is mirrored,
then tap
Continue.

12" x 12" Material, Mirror On
cut

Wl ETET LTE 10:34 AM

Step 8: Place il
your iron-

on vinyl on
your cutting
mat shiny
side down,
load the mat,
and press
the flashing
button on
your Cricut
cutting
machine.

Mal 1 ol 1

@ Loud 1wols andt mal

';1\ Izterial cef: Everyday Iro...

Progeure : Dol /1 Miake 302 Mmor ks

Practice this at https://jennifermaker.com/simple-smile

- in the

upper
left
corner
of the
screen.

Step 6: .||E|&T LTE 10034 AM
Tap on All
Materials.

Wil 1 ol 1

Remember, put the vinyl
SHINY SIDE DOWN on your
cutting mat!

Y COPYRIGHT JENNIFERMAKER®
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CRICUT® COACH PLAYBOOK

HOW TO USE

SNAPMAT

A useful feature of Cricut Design Space on iOS is SnapMat, which allows you to take a photo of your
material on the mat and then position your items on it. Here’s how to use it:

all ATET LTE 12:04 PM

Step 1: Open ¥}
the Cricut

Design Space

app and tap

New Project.

My Projects in the Cloud ¥

Love Decal Android

QOswwe w0 @ s

@ search wil LTE 12:10 PM

Step 4: Place E™ SR
your material
on a mat and
place the mat
on a light or
white colored
surface.
Center the
mat in the
border. When
it is centered,
the app will
take a photo
automatically.

Step 7: If you
have multiple
mats in your
project,
you’ll need
to repeat
steps 5-6 for
each mat.
(Yes, that
means you
need to take
new SnapMat
photos for
each mat.)

Wl ATET LTE 12:04PM

Step 2: Butterflies *
Insert 1

images or

a project

onto your

canvas. Tap

Make It.

orLs
im:

Image  Text Shapes Upl

@ search wil LTE 12:10 PM

Step 5:
Look at
the photo
taken.

If you
like it,
tap Use.
If you
don’t like
it, tap
Retake.

Step 3:
Tap the
SnapMat
icon.

SnapMat

elements
on to the
best spots
on the
mat.

il ATET (TE 12:04PM

& Mat 1 of 5

12 x 12 mat, Mirror Off

@ search wtl LTE 12:11PM

& Mat 1 of 5

12 x 12 mat, Mirror Off

il AT&T LTE

Step 8: When ready, ]
tap Continue, choose

your materials, and

make your cuts!

Tip: If SnapMat won’t
take a photo of your
mat, make sure you’ve
got good lighting and
put something white
(like a white sheet)
under the mat for
better contrast. Hold
your device parallel to
the surface.

1214 PM

Mat 2 of 5

Adnesive Foi, Matte | Aluminum - Burlap, Bonded
0.14mr
¢

Practice this at https://jennifermaker.com/butterflies
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CRICUT® COACH PLAYBOOK

HOW TO SAVE WORK AND
VIEW SAVED PROJECTS

4:34PM
Untitled *

7 % (-

Step 1: Create []j .

something and
tap the Save
icon. You can tell
if something is unsaved if
it says “Untitled” at the
top of the window, or an
asterisk * appears next
to the title if you saved
previously.

Step 3: Give the
project a name and
tap Save to the Cloud
if you want to access
it elsewhere, or Save
to Phone (or Save to
iPad) if you want it
only on this device.

Save Project As
[ Love Decal
Save to the Cloud
Save to iPhone

Cancel

gwe rrtyuiop

To view your Saved Projects, tap the
left panel in the three-panel icon,
then tap Home.
tap here

Home Canvas Make

Then tap the Categories menu and choose either
My Projects in the Cloud or My Projects on this
iPhone (or iPad).

To share a project, click on a saved
project then tap the Share button on
the left side of the window.

@ Share

Note: Projects with images or fonts that must be
purchased to use cannot be saved to your iPhone
or iPad without first purchasing them.

il AT&T LTE

Step 2: Tap Save from [d‘
the drop-down menu —
that appears. If you

see Save As appear,

that means you saved

it before and you have

the option to save

it with a different

name to preserve the

original save.

Untitled *

If Cricut is able to

save your project, a
confirmation window will
appear.

Saved Love Decal to iPhone.

@

7 % @) il AT&T LTE

® ESE

Categories v = QSearch in All Categories My Projects on this iPhone ¥

®

My Projects in the Cloud

LV
VE

My Projects on this iPhone

My Favorites

My Ready-to-Make Projects

New Project
All Categories

Q Cricut Access

Cricut Community

Accessories

Anna Griffin

Baby

Cards

Christmas

| R RS RODN S N -

Practice this at https://jennifermaker.com/love-decal

Love Decal

() share

-
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CRICUT® COACH PLAYBOOK

HOW TO
SAVE FOR OFFLINE WORK

With the Cricut Design Space for iOS app, you can save projects for offline and access them even when you

aren’t connected to the Internet. Here’s how to do it:

2:24PM

Step 1: Save P Love Decal

a project
following the
directions on

the previous
page (page 67). If
you’ve already saved

this project before in the
Cloud for online work,
tap Save As instead of
Save. If you’re not sure
where you’ve saved it,
tap Save As.

Step 3: If successful,
Design Space tells you
that your project was
saved.

' Saved Love Decal to iPhone.

Ll ATET 227PM 7 Q098% (4

Step 2: Type in a name ©© Love Decal m
if you haven’t already o
given it one, then tap
Save to iPhone or Save Project As

Save to iPad.

qwerr ty ui op

Step 4: To view your
projects saved for
offline, tap the left
panel in the three-panel
icon to take you Home,
then tap the Categories
menu and choose My
Projects on this iPhone
(or iPad).

 There is currently no way to batch save all of your projects for offline. You must click each one and select

“Save for Offline” individually.

« If you go offline, you’ll only be able to view and access projects saved on your iPhone or iPad.
» Any images you have in a project from Cricut Access will expire after 30 days if you do not go online at all
during those 30 days (even if you have monthly access). So be sure to set a reminder to go online at least

once every 30 days.

» You cannot upload anything new while offline (this means even from your iPhone/iPad or images within
Design Space). So be sure to save all images you want in a project/canvas before heading offline.

Practice this at https://jennifermaker.com/love-decal
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CRICUT® COACH PLAYBOOK

HOW TO
SHARE LINKS TO PROJECTS

Did you make an awesome design and now want to share it? You can so long as there are no uploaded
images in your project. (You cannot share projects with images you uploaded.)

il ATRT LTE 4:39PM

Step 2: You wi“ likely Cancel Project Details
be prompted for more S
information first. Shared

il AT&T LTE 4:37PM 7% -

Step 1: Open a ®
project you saved My Proectsnthe Glood ¥ | Q
in the Cloud (see

©

Visible 10 Others (1)

previous page) and

tap Share.

N LY
| VE

New Project

projects must have a title,
description, and at least
one photo. Add at least one
landscape photo by tapping

the + button.

Note: If your design has any purchased elements from Cricut Access or cartridges,
anyone attempting to use your design either must also have them, and if they do
not, they will be prompted to pay for them before cutting.

Step 3:
Toggle
Visible to
Others
to On
(green).

Step 6:
Type in

a note
and click
Post. Your
project

is now
shared to
Facebook.

Note: The URL for these projects will look something like this:

Wil ATRT (TE 4:39PM

Cancel Project Details

x

Visible to Others (1)
Title

Simple Love Dacal

Description

Simple love decal

gwer tyu

Cancel Facebook

% Jennifer Maker Marx
&4 Posting to Facebook, @ Only me

Love decal |

simple Love Decal
Simple love decal

-
g

Step 4: Edit
your title
as needed
and add a
description.
When done
editing, tap
Save.

Step 7:

Go to
Facebook,
find the
post you
just shared,
and tap

the Share
button.

Wil ATRT (TE 4:39PM

Cancel Project Details

Visible to Others (1)

Title
Simple Love Decal

Description

Simple love decal

WIATET LTE 7:36PM
< Jennifer Maker Marx
<) 3hrs - Cricut Community - @
My Love Decal

DESIGN.CRICUT.COM
Love Decal by JenniferMaker
A simple Love with a heart.

o Like (D Comment

Be the first to like this

&> Share

(3) | write acomment...

®0
e ? 5 & 2=

Step 5: Tap
Facebook to
share your
project.

Step 8: As
soon as
the link
opens, tap
the three
dots in the
upper right
corner and
tap Copy
Link. Now
you have
the link!
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Title
Simple Love Decal

Description

Simple love decal

Wl ATET (TE a:41PM

Share Project

Share this project on Facebook.

Simple Love Decal

& design.cricut.com
| View saved items

Open in Safari

Copy link

Mark link as suspicious

Facebook Mobile Browser

Cookies

“This website uses cookies. By using and further
navigating this website you accept this. Detailed
information about the s of cookies on this website is
available by clicking on more information.

https://design.cricut.com/#/landing/project-
detail/5c36621aa573630635ea6e56

SHARE PROJECT LINKS




CRICUT® COACH PLAYBOOK

HOW TO
FLATTEN

Need to make a Print Then Cut project? Flatten is your friend! The Flatten tool allows you to turn any
image into a single, printable layer for the Print then Cut feature.

Step 1: Add two or more items
to your canvas that you want to
flatten.

o

l@m@@%z&}@

Image  Text Shapes Upload Actions  Edit Make It

Step 2: Tap and drag a selection
box around all objects you want to
flatten to select all of them.

all ATRT & 1:49 PM

@ Hearts * EI:)
,Z“"“‘b"“‘ Layers ®

Step 3: Tap - Y Flfttened Set o 7
Actions, then I-_II_‘I < : ‘ i oulem |
tap Flatten. Actions Flatten S x) (46) (05 =) (i

“Vertical H Position V Position Align  Distribute

(v)

4 € € € €

o
FLATTEN

Note that all items are now on one @ Ej ShE U@m =t EE& 1 Mg,t
layer and now work only for Print | ‘
Then Cut.

If you decide this isn’t what .
you wanted to do, tap the ¥
Unflatten button right away. unfatten

-
® a &N 3
s Uplol Actions MJEdit  Sync Layers Undo Make It

Practice this at https://jennifermaker.com/five-hearts
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CRICUT® COACH PLAYBOOK

HOW TO PRINT THEN CUT

Step 1: Find or upload a printable image less than 9.25” high by 6.75” wide with one of these two methods:

Method A: Search for printable Method B: Upload a PNG with a transparent background.

images in Design Space by @
tapping Filter and checking

“Printables” under Type.

WIATRT =

Clean up anything Refine any cut paths Tap the image on the
you don’t want & tap you wish then tap right, give it a name,
Fiters o Next. Next. then tap Save.

Categories v Cartridgesvy

PRINT THEN CUT

Printables x

Ownership
@) Cricut Access Al ATRT & 4:50 PM e |LicaE

Cancel Clean Up { Clean Up Refine
Purchased

Type

Any Type

3D Objects
Backgrounds & Textures
Borders

Cards & Envelopes

Frames

e @ ® Phrases v

e x Printables O

Visible Close Inst
Tip: The printer icon in

the Image library indicates a
printable image.

Clean up your image using the tools below.

Step 2: Select and Step 3: Make sure Step 4: Connect Step 5: Select Step 6: Select
insert the image you see “Print your Cricut (if your printer, your Material (i.e.
onto your Canvas, Cut” here, then necessary) then turn off Bleed (if Printable Vinyl).
then tap Make It. tap Continue. tap Send to Printer.j} available), and

click Print.

WIIATET = 4:35PM b wilATET = 4:36 PM 73 @ search wil 4:39 PM T3 @ search wil = 4:40PM T3 @ search wil =

& & untitled * i Mat 1 of 1 amm O Mat 1 of 1 (TR cancel Printer Options
16 7 0 i i0 |

Printer Select Printer
1 Copy + @ Printed

o Set material

Step 7: Place your printed
page on your cutting mat,

load it, and tap Go. . . L .
Practice this at https://jennifermaker.com/rainbow-heart
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CRICUT® COACH PLAYBOOK

HOW TO
UPLOAD IMAGES IN IOS

Step 1:
Tap New Project

Step 2:
Tap Upload

Wil AT&T LTE 11:06 AM 73 -

Step 3:

Tap Browse Files or
Select from Photo
Library, depending on
where you saved your
file.

My Projectsiin the Cloud ¥

s oL

New Project Rainbow

@ share

Do what youlove

)
‘ A

Do What You Love Rai...

(@) share 000

Do What You Love Rai...

(@) share 000

ALY (G Rt
Image  Text Shapes¥y Upload Actions

Step 5:

Clean it up (if
you want) and
tap Next.

Step 4:
Tap the image file ,
such as PNG, JPG, GIF,

9:53 AM <~ @ il AT&T LTE

Camera Roll Cancel Cancel

Clean up your image using the tools below.

;s & u

Uploadlimage

Select from Photo Library

Browse Files

Open Uploaded Images

Cancel

Make it [

Step 6:

Choose an image
type, name it, and
tap Save.

Rainbow Heart]

Tip: Type a word or two
as a tag to help you find

this image later in a
search.

Remove Erase Crop Undo Redo

Note: If you want to
use the Browse Files
feature, be sure you
are running iOS 11 or
later on your device
and upgrade if not.

ol T LTE

£ eral

12:40 PM

Software Update

ios 1
.x Apple Inc
=8 GR

iOS 12 brings performance improvements and
exciting new features to iPhone and iPad.
Photos introduces new features to help you
rediscover and share the photos in your library,
Memoji—a new, more customizable Animoji—
make Messages more expressive and fun,
Screen Time helps you and your family
understand and make the most of the time
spent on devices, Siri Shortcuts deliver a faster
way to get things done with the ability for any
app to work with Siri, augmented reality
becomes even more engaging with the ability
for developers to create shared AR
experiences, and new privacy features help
protect you from being tracked on the web.

For information on the security content of
Apple software updates, please visit this

website:
https://support.apple.com/kb/HT201222

Step 7:

Tap the uploaded
image and then
tap Insert.

Cartridgesy Q.

Reset All

Practice this at https://jennifermaker.com/rainbow-heart
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CRICUT® COACH PLAYBOOK

HOW TO ERASE A

BACKGROUND FROM AN IMAGE

Step 1: Find or
upload a JPG,
PNG, GIF, or BMP
file that you want
to use.

Step 3: Tap

on the white
background
around your
image to erase it.
You may need to
click in several
areas to get it all.
The slider at the
bottom controls
how much of a
given color you
remove. When it
looks good, tap
Next.

Step 5: Decide
if you want

to save it as a
Cut Image or a
Print Then Cut,
give it a name,
then tap Save.

il AT&T LTE 9:53 AM il ATET LTE 10:15 AM < -

Cancel Clean Up Step 2: Tap the b Cancel Clean Up Next

Remove tool . P

Tap areas you want to remove.

Clean up your image using the tools below.

/w’ & N ®

Undo

il ATRT LTE 9:54 AM

..-:;T:‘T::'E C:;‘:p @ Step 4: Check the < Clean Up Refine
cut lines of the
object. If you need
to fix it, tap Clean

Up. If it looks good,
tap Next.

Tap areas you want to remove.

Refine cut paths using the tools below.

4 x

ol ATET LTE 7 w— il AT&T LTE 9:55 AM 7 @

< Refine Aalmace Step 6: Once Categories v Cartridges v~ 1 <
saved, you can gr— S
use the image by
selecting it and
clicking Insert
Image.

Rainbow Hear{

9 0
1) D o
=
= @ (
Selected \ /
pe

Practice this at https://jennifermaker.com/rainbow-heart
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CRICUT® COACH PLAYBOOK

HOW TO

COMBINE MULTIPLE PROJECTS

While there is no built-in function in Design Space that allows you to combine projects, there is a

workaround. Here’s how you do it:

< safari | T 6:05PM 7 100% w-"

Step (K @B CﬁlﬂrfuIBlmerfllesbyJenmfe )
Open the ‘ S
project

you want

to add to

another

and turn

off the grid

by tapping

Settings

and toggle

the Grid

off.

< safari | T 610PM

@ () Do What You Love Rainbow* ( Jl])
I P i O o |

Step 4:
Open the
project

to which
you want
to add
your other
project.
Allow it
to replace
your
current
canvas.

A

B4 Bad el

Step 7: Tap @ () Do What You Love Rainbow* ( Jl])

the first RE—————————
project’s e
image, tap &

Actions,

tap

Duplicate,

and make

as many

duplicates

as there

are

elements

in the

project.

Practice this at https://jennifermaker.com/butterflies and h

< safari il T 6:20PM 7 97% -

Step 2: @E’ ColorfulsunermesbyJenmfe @M
If any B
individual
elements
in your
design are
touching
and you
need them
separated,
move
them
apart now.

Image  Text  Shapes d  Actions  Edit

< safari | T &12PM

Step 5:  Refine
Follow
previous
pages to
upload the
image from
step 3 and
remove

the back-
ground. Tap
Cut Image
then tap
Save.

Save Image

“Butterflies”

qgwer r tyuiop

c [“] Do What You Love Rainbow * m

—

Show All Contours

Step 8:
Select each
duplicate
copy and
tap Actions
> Hide
Contour
(see page
53) to
separate
out each
element
into its own
layer.

N

Step 3: Take a picture of Design
Space screen by pressing the Side
button and the Volume up button
at the same time. Quickly release
both buttons. Tap the thumbnail
of your screenshot that appears
in the lower-left corner, and crop

it (slide in

the sides)

to adjust
the design.
Tap Save to
Photos.
é E] Do What You Love Rainbow * (]:]

Step 6:
Insert the
newly
uploaded
image
onto your
Canvas
with the
other
image
from step
4,

Step 9: '?’é"'g DoWha‘:::p:veRainbaw» @M
Recolor N e P e S e
each
element
(see page
21) as
needed
and move
back into
position.
Now

your two
projects
are
combined!

lo Fill /) 38 a 24

ttps://jennifermaker.com/rainbow-love
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CRICUT® COACH PLAYBOOK

HOW TO UPLOAD SVG FILES
ON AN IPHONE OR IPAD

SVG files are special files that you can upload to Cricut Design Space and cut beautiful designs from.
To use an SVG, first you must download and unzip an SVG file. You can practice downloading a file at

ennifermaker.com/svg-heart. To unzip a file, go to the Files app on your iPhone or iPad, locate and tap

on Downloads, tap and hold the downloaded ZIP filename, and choose Uncompress from the drop-down
menu. Note that you will not see the folder in step 4 unless you do this first.

Be sure you are running
iOS 11 or later on your
device (check in Set-
tings > General > Soft-
ware Updates). If not,
upgrade first.

L eral

ios1
.‘ Apple Inc.
58 GB

iOS 12 brinys e formance improvements and
exciting new features to iPhone and iPad.
Photos introduces new features to help you
rediscover and share the photos in your library,
Memoji—a new, more customizable Animoji—
make Messages more expressive and fun,
Screen Time helps you and your family
understand and make the most of the time
spent on devices, Siri Shortcuts deliver a faster
way to get things done with the ability for any
app to work with Siri, augmented reality
becomes even more engaging with the ability
for developers to create shared AR
exneriences and new nrivacv features heln

Step 4:

Tap the SVG file (do
NOT tap the ZIP file—it
will give you an error).

Software Update

il ATET = 10:21 AM 73 @)

{ Locations iClou{ Drive Cancel

Q Search

E‘P Sorted @ Name ¥

&

GarageBand
foriOS

3items

21 May 2017 ch
19/36/48 0

y

zip
miniature-
jennifermaker \\ jennif...er-SVG /' rose-j...aker-1

8:40 AM
287 KB

Recents,

Step 1:
Tap New Project

My Projectsiin the Cloud ¥

New Project Rainbow

@ share

ST

SN

Dowhat you love

A

Do What You Love Rai...

@) share 000

Do What You Love Rai...

(@) share 000

Step 5:
Tap Save.

il ATRT =

Cancel

Tip: Type a word or two
as a tag to help you find
this image later in a
search.

Step 2:
Tap Upload

Step 3:
Tap Browse Files

L I

Uploaflimage

Take @Photo

IR ¥ B

Browse Files

cooasl

Open Uploaded Images
Actions % Make It r ‘

Once inserted, your
image appears on your
canvas, ready to be
modified and/or made!

Step 6:
Tap the uploaded
SVG and then tap
Insert.

10:27 AM Wil ATRT & 10:2 3 AM

untit >d * m

[ P

Cartridgesvy O T

Reset All

_3

"
v

Y

Download
Selected

) @ S ® %N

Text Shapes Upload Actions  Ed| Makelt

Practice this at https://jennifermaker.com/svg-heart
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CRICUT® COACH PLAYBOOK

HOW TO
RESIZE A PROJECT

Have you ever uploaded an SVG design, cut it out, and realized it was too small or too big? Here’s how to

check the size before you cut it out:

< Safari wi! & 9:21PM ¥ 80%@m)

Step 1: Insert, @) ) colorful Butterfies by Jennite... (i)
upload, or create T R RO
an image on your )
canvas in Design
Space, then
select all images
you want to
resize by tapping
and dragging a
selection box
around them.

SEENCRC N W

s Upload Actions  Edit Make It

|

< Safari wi! & 9:21PM ¥ 80%@m)

Step 2: Tap Edit! @E’] Colorful Butterflies by Jennife... CI]
then note the size P U PP IS PO o |

at the bottom of the
window in the Width
and Height circles.

10.6 a

Width

4.4

Height

B cut @

© Linetype

B &

Image  Text Shapes Upload Actions

To determine if the sizing is right, compare it to the sizing in the original instructions or tutorial. If no sizing
is provided, you’ll have to use your best judgment. Here’s how to resize a project:

< safari 1| 9:22 PM 7 80%@m)

Step 3: Be sure @E} Colorful Butterflies by Jennife... Clj
the lock icon | PPV SOPYON ORI POVON U

indicates it is
locked, then

tap the Width

or Height circles
and tap on the
number pad to
enter the proper
size.

T,

S cut @ NoFil

o Linetype

M ® 5 RS

Shapes Upload Actions  Edit  Sync Layers U Makelt

You can also resize images using the resize icon
in the lower right corner of a selection box.
Just click, hold, and drag to resize.

< Safari wi! & 9:24 PM 7 79% @)

The entire @ (%] Colorful Butterflies by Jennife... ( Jl|)
selected e o e A e
image(s) is )

resized and

retains its

proportions.

5 a 21

Width

Height

Note that Cricut Design
Space will automatically ~
resize any SVG file that ~ °' " T C o 2
measures over 23.5" R o

(either wide or high) S G o CR G im0
down to 23.5” on its longest side, and there is no
notification that an image was resized. So if you ever
place an image on your canvas and notice that one
side measures exactly 23.5”, that is a strong indicator
that your image has been resized.

Practice this at https://jennifermaker.com/butterflies
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CUSTOM MATERIALS SETTINGS

CRICUT® COACH PLAYBOOK

HOW TO USE AND MODIFY

You can use and modify settings for MANY materials using the Custom Materials settings in Design Space.
Here’s how you access and change them:

Step 1:
Tap your
profile
circle

in the
upper left
corner
and tap
Manage
Custom
Materials.

Step 4:

Tap the
setting

you want
to change,
likely the
one labeled
Preferred.

Step 7:

If you want
to create
an entirely
custom
material,
tap +, type
a name for
it, then
tap Add.

o1l ATAT 7:47PM

Wi ATRT T 7:46 PM
£ JenniferMaker Manx
& view profie
Machine Selection — Maker ’

™

Machine Setup & App Overview

Cricut Access™

print Then Cut Calibration

fanage Gustom Materials

Help & Fesdback

About

Sign Out

b (e

ced_Hide Contour

Version 4.0.1

7 94% -

< Edit Name Save

110 Ib. Cardstock

Deep-Point Blade

Rotary Blade

110 Ib. Cardstock

Acetate

Name Material

AJRESh ¢ 1ter a name for your new material

[ ——
Adhesi
N Cancel
Auminum Foi
Bamboo Fabrio

Bengaline

Step 2: If
prompted,
tap your
Cricut
here. Give
it some
time to
load your
settings.

Step 5:
Change the
settings
here as
needed.
Usually |
just adjust
pressure,
but you
can change
how many
times it
cuts, too.

Step 8:
Change the
settings
here as
needed,
then tap
Save. You
may need
to test

to get
the right
settings.

o1l ATAT 7:47PM

Cancel Select Device

CONNECTED DEVICES

Maker-4392

o1l ATAT

< Edit Settings Save

7:48 PM 7 93% )

PREFERRED ACCESSORY

Make this the preferred blade for this material

o1l ATAT

< Edit Settings

7:49 PM

PREFERRED ACCESSORY

Make this the preferrecdg®S for this material

SE

Step 3:
Scroll
through
the list of
materials,
find one
you want
to edit,
and click
the arrow
button to
the right
of it.

Step 6:
When
done, tap
Save.

Step 9:

Set your
dial to
Custom
(Joys and
Makers are
on Custom
by default),
and then
choose a
custom
material
before you
cut.

PAGE 77 <Y COPYRIGHT JENNIFERMAKER®

o ATET T 7:47PM

Done Material Settings aF

7 94% -

CUSTOM MATERIALS

110 Ib. Cardstock
Acetate
Adhesive Foil

Adhesive Foil, Matte

Bengaline

Birch, Permanent Adhesive
Boucle

Broadcloth

Buriap

Burn-Out Velvet

Calico

o1l ATAT

<

Make this the preferred blade for this material

CUT PRESSURE

o

MuLTI-CUT

7 93% ).

vy —
Bonded Fab®

° Set material

c Art Board
Medium Cardstock | Foil Poster Board | Vinyl
8010 (216 gsm)

€ €

Light Cardstock -
601b (163 gsm) 75 gsm)
¢

®

Cancel

CopyPaper~201b | Everydaylron-On | Infu
Tar

CUSTOM MATERIALS




CRICUT® COACH PLAYBOOK

HOW TO UPDATE THE
CRICUT APP IN IOS

Step 1: Open your Cricut Design
Space app. If a new version is
available, it will tell you. Tap Update.

New Version
Version 4.0.1 is available on

tore
Not Now Update

Step 2: Tap Update. Make sure you
have a good Internet signal for the
best results.

{ Search

e
46**** ; #

What's New

Version 4.0.1 6d ago

Version History

« Subscribe to Cricut Access through Design Space for
ios!
« Fixed several purchasing issues more

Preview

Make It Now Projects Design St

Alternatively, you can go to the
Home screen and tap the App
Store to check for updates.

12:37 P

> @

Mes ages Calendar Photos Camera

=

Cricu’ Jesign Weather

i 12 1

v
A 2
AR
/Y
- ./‘
7y s

Notes i Clock

* 2

iTunes Store REENG
> 8]

Settings FaceTime

f

Facebook

eeeccecee

Step 3: Wait for Cricut Design
Space to update, usually no

more than a few minutes.

Wl ATRT &

{ Search

( ricut Design Space
& 0 Craft & Novelty

4.6 %%k k K 4+

19K Ratings festyle Age

o

What'’s New
Version 4.0.1 6d ago

Version History

« Subscribe to Cricut Access through Design Space for
ios!
« Fixed several purchasing issues more

Preview

Make It Now Projects Design St

Once in the App Store, tap
the Search icon and search
on Cricut Design Space.

wll AT&T LTE 8:37 AM 7 -

Q. cricut design space @ Cancel

Cricut Design Space
6 Lifestyle

b.8.8.8 8 4

Make I Now Procts

Cricut Basics
Lifestyle

basics ek Ty

UPDATE APP (I0S)

Step 4: Tap Open to launch
the updated version of the
Cricut Design Space app.

{ search

What's New

Version 4.0.1 6d ago

Version History

+ Subscribe to Cricut Access through Design Space for
ios!
« Fixed several purchasing issues more

Preview

Make It Now Projects Design St
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CRICUT® COACH PLAYBOOK

HOW TO TROUBLESHOOT
DESIGN SPACE PROBLEMS

Your ability and willingness to troubleshoot problems is a high factor in your success with your Cricut (and
really, most things in life). Problems happen, but you CAN solve them. Here are the steps | take when |

encounter problems with Cricut Design Space:

Cricut Design Space is acting weird or not working at all.

Is it down? Check status.cricut.com

Watch the status site for it to come back. Yes No

Still having problems? Is it installed and up-to-date?

Yes Restart your device. Yes No

Are you still having problems?

Have fun and make
something awesome!

Do you have a strong Internet connection? Yes No

Keep the app with Design Yes No
Space open and don’t
move away while cutting.

Connect to Internet &
move your Cricut and
device closer to router.

Are you still having problems? Still having problems?

Close any other apps running on your Yes No
device.
Are you still having problems?

Make sure your Cricut is actually en No

connected via Bluetooth.
Are you still having problems?

Disconnect your Cricut, restart your

. . Yes
device, and reconnect your Cricut.

Are you still having problems?

Yes No

Having different problems?
Here are more solutions:

Machine problems:
Check the Cricut site at

https://help.cricut.com

Cutting problems:

Check my ideas at
https://jennifermaker.com/
cutting-problems

Mat problems:

Check my mat tips at
https://jennifermaker.com/
mat-tips

Blade problems:

Check my blade tips at
https://jennifermaker.com/
blade-tips

Contact Cricut Member Care at https://help.cricut.com. | recommend the Chat option when available—
you can also call during open hours or email them at anytime. Cricut Member Care is very helpful!
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CRICUT® COACH PLAYBOOK

HOW TO INSTALL
CRICUT DESIGN SPACE

Step 1: Connect your Android device Step 2: Tap in the search bar at Step 3: Tap Install
to the Internet, go to the Home the top and type “Cricut” then and wait for it to
screen, and tap Play Store. tap Cricut Design Space app. download & install.

Space

Cricut
Q cricut design space app for chromebook
In-app purchases

4.2% ™+

Q. cricut design space app for android
41K reviews Downloads Everyone ©®

Q  cricut design space app update
Ann  “bor

Uniated 51 139PMC5
Q cricut design space app free

About this app

Welcome to Cricut Design Space for Android!

9 spaces spaced spaceship spacers
e 6 D #2 top grossing in lifestyle
0

Calculator ign Play Store
Rate this app
Tell others what you think

SRS S S X S x 6

Write a review

@) s 1

Step 4: Tap Open. Make sure you Step 5: Tap Sign In (if you Step 6: Enter your Cricut
have a good Internet signal for the already have an account). If sign in email and password
best results. not, tap Machine Setup. to begin using the app.

cricut.

Cricut Design

Cricut

tfricut‘

Uninstall

ads - Suggested for you Welcome to

Design Space® cricut.

Canva: Graphic  Coinbase ~Buy  Amazon Pinterest Adot
Design, Video C.. & Sell Bitcoin. C..  Shopping-Sear.. 45 4 Reac

47 % 24 % 46 * 461

@ jours@example.com

6  Enterpassword
You might also like

Forgot password?

9 |
OB a
(&

Background Disney+ Microsoft Word:  Crash Bandicoot: ~ Cany
Eraser 43 % Write, Edit &Sh..  On the Run! Desir

46 % 44 % 4% 471

Machine Setup

About this app

] 1} (0] <

OPEN & START PROJECT

PAGE 80 ¥V COPYRIGHT JENNIFERMAKER®




CRICUT® COACH PLAYBOOK Android

HOW TO OPEN AND START
A NEW PROJECT

6:00 ¢ @ * X

Finder search

Q00 oy All Categories ¥
o

Samsung Google Microsoft Apps  Play Store Camera

o o
\‘jw, Diwali Fireworks Bann. Traditional Diwali Ban.
Settings Calendar .
w Qg

Q 1 '

PlayMusic ~ SamsungNotes  Spotify Audible

Tip: If this is your ST G
first time using
Cricut on your
device, see page
80 for details on
how to install it.

Diwali Candle Holders

Ve

oral Diwali G Boom Pow Bang Card

Warning: If you get an error message upon opening the Cricut app, it probably .
means your WiFi connection is missing or not strong enough for Cricut to retrieve
your account information. Move within range and try again.

You will
get a new
canvas,
ready for
you to add
images,
shapes,
text, and
projects!

Canvas

Replace Canvas Content

Do you want to replace Canvas content and lose any changes you have
made?

OPEN & START PROJECT



H

Note: Your Cricut
must be within
10-15 feet of
your device.

If you need to
use a Wireless
Bluetooth
Adapter, make
sure it is
inserted.

CRICUT® COACH PLAYBOOK

W TO CONNECT VIA
BLUETOOTH

617 t @

Finder search

49 8
@0 ©c

Google Microsoft Apps  Play Store Camera

Contacts Calendar

o0 @ <>

Calculator PlayMusic  Samsung Notes Spotify Audible

Once paired, it
will appear in
your Bluetooth
window under
Paired Devices.

Bluetooth pairing request

Enter PIN to pair with Maker-4392.

PIN

q w e r t y u i o p @
a s d f g h j k | Done
tl z X c v b n m +
Ctrl w1 English (US) 4 >
11l (@] B

619@ e *

< Bluetooth

Stop  Advanced

Make sure the device you want to connect to is in pairing mode. Your tablet is

visible to other devices as Galaxy Tab A (8.0", 2019).

Available devices

Cf  ENVY Photo 7100 series
O Maker-4392

QO  CricutAIR2-27E0

OO NO4KN

T ENVY Photo 6200 series

620 @ ¢

< Bluetooth

Scan  Advanced

o )

Make sure the device you want to connect to s in pairing mode. Your tablet is

visible to other devices as Galaxy Tab A (8.0",2019)
O Maker-4392
Available devices

CQ  ENVY Photo 7100 series
Q  CricutAIR2-27E0
O NO4KN

CQ  ENVY Photo 6200 series

Android

CONNECT VIA BLUETOOTH



CRICUT® COACH PLAYBOOK

HOW TO ATTACH
TO KEEP THINGS TOGETHER

Step 1: Add all 5 ’ Step 2: Tap and drag
of your elements - g ‘ a selection box around
to the Cricut all of the images
Design Space app ; you want to attach

on your Android together, tap on
device, including Actions at the bottom
text, SVG designs, == I ' of the screen, then

score lines, write tap Attach.

lines, etc. C -
r I C u t Note that attached

layers will take on the
same color. So only
attach layers that you
really want to be the
same color!

Layers "
Layers

v ATTACH
v ATTACH

v Heart
v Heart

V- | v -

v TEXT Cricut Shs

v TEXT-Cricut Sans

C- w l® C-

v TEXT Cricut Shhs
v TEXT -Cricut Sans

| - Cricut | -

W
D B s o

= <)

i o o

Practice this at https://jennifermaker.com/i-love-cricut
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ATTACH THINGS TOGETHER



http://jennifermaker.com/i-love-cricut

CRICUT® COACH PLAYBOOK

HOW TO
GROUP AND UNGROUP

HOW TO GROUP:

Step 1: Tap Layers
and select each
layer you want to
group together.
Alternatively, you
can tap and drag a
rectangle to select
objects.

HOW TO UNGROUP:

Step 1: To ungroup,
tap the Layers button
in the bottom toolbar
and look for the
word “Group.” (Hint:
There may be more
than one!)

Step 2: With all
objects you want

to be in a group
selected (the left side
of the layers turn
green when they are
selected), tap Actions
in the bottom toolbar
then tap the Group
button.

-
B

Croup

Step 2: Tap the word
“Group” in the Layers
panel to select it,
then tap the Actions
button and tap the
Ungroup button.

Practice this at https://jennifermaker.com/smiley-face
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CRICUT® COACH PLAYBOOK

Step 1: Insert any images you Step 2: Tap and drag a selection box around all
want to weld onto your Canvas. of the images you want to weld together, tap on
Actions at the bottom of the screen, then tap Weld.

oo

Actions

 Layers

v Weld Result

|* cut

ol

Practice this at https://jennifermaker.com/butterflies
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CRICUT® COACH PLAYBOOK

HOW TO SLICE
(CUT AN IMAGE OUT OF ANOTHER)

Step 1: Insert T s
your images onto ' i
your Canvas so
that they are
overlapping.

Step 3: Move, e e
hide, or delete
st the layers you do
Yo not want, then
v sttt you’re good to
VA go!
-

U ®

-

Practice this at https://jennifermaker.com/heart-slice
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CRICUT® COACH PLAYBOOK

HOW TO REMOVE
PARTS WITH CONTOUR

Step 1: Choose
an image with
elements you’d
like to remove
then tap Actions,
then tap the Hide
Contour tool in
the lower right
corner of the app
window.

Step 3: Elements
that appear darker
are those that you’ll
remove. When your
image looks the way
you want it to, click
the X icon in the
upper right hand
corner to return to
your canvas.

Home Canvas Make

5 f6 P B B o pz pTRE T e 7 pe e

Step 2: Tap on
the elements you
want to remove.
You can make
the image larger
(to see detail)

by pinching to
zoom.

Step 4: Confirm
that your image
looks the way
you want it.

If you need

to make more
changes, just
click the Hide
Contour tool
again.

=2

* TP

CONTOUR (REMOVE BITS)

Practice this at https://jennifermaker.com/pink-star
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CRICUT® COACH PLAYBOOK

HOW TO
CURVE TEXT

Step 3: Tap the text,
tap Actions, and tap
Isolate Letters.

Step 1: Tap the Text
tool and add some

text.

=) Do What You Love.

Step 2: Tap Shapes
then tap Circle.
Resize the circle to
match the curve you

Step 4: Move each
letter so it’s base
lines up with the
circle below.

Home
[ TR T

" Dowhat youlove

A

Step 5: As you work,
rotate the letters to
match the curve of
the circle.

Cricut Alphab..Ao R
s

Step 6: Keep going
until all the text is
in position.

Step 7: Check that
your curves look
smooth and your
words readable.

Step 8: Delete the
circle and group all
letters so they are
easy to move around.

-
x
[N}
[
S
4
D
(©)

Tip: If you have difficulties moving the letters into position, it may be because SmartGuides are turned
on. To turn them off, tap Settings in the bottom toolbar and toggle off SmartGuides.

Practice this at https://jennifermaker.com/rainbow-love
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https://jennifermaker.com/rainbow-love

CRICUT® COACH PLAYBOOK

HOW TO ALIGN AND
DISTRIBUTE OBJECS

Step 1: Add two or more
items to your canvas
that you want to align or
distribute evenly.

Step 3: Tap on the Edit

tool in the bottom
toolbar, tap Align, and
tap Align Bottom.

# Center

=, Align Left

= Align Right

T Align Top

=, Align Center

{# Align Middle

Step 5: Tap on the
Edit tool in the
bottom toolbar, tap
the Distribute tool,
and choose Distribute
Horizontally.

Step 2: Tap and drag a
selection box around
all items you want to
align and/or distribute.

Step 4: All selected
items are aligned
with the bottommost
object. Now let’s
space them out
evenly.

Step 6: Note that all
the hearts are now in
a perfect row with the
same spacing.

Practice this at https://jennifermaker.com/five-hearts
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Step 1:
Tap the ‘1,+
Text tool,

Text
choose a
font, and
type something
onto the Canvas.
Note how the
letters are spaced
widely apart. Let’s
fix that.

Step 3: The letter
“D” is too close

to the “0” in the
example here.
Select the text and
tap Action then tap

Actions

CRICUT® COACH PLAYBOOK

HOW TO CHANGE

Pricnt Alnhah A
Do what you lovel

Step 2: Select the
text, tap Edit, tap
Letter Space, and

tap the minus sign

until the letters look
better.

Cricut Alphab..A

Yz

Step 4: Select just oo o

the letter “D” then
tap Edit, then tap

H Position, and tap
the + symbol to move
it to the right. Now
these words are
properly spaced.

D ()

Edit H Position

Important: You will
want to select all
letters and tap Action
then tap Group to
make sure your
letters stay together
when you cut them.

Practice this at https://jennifermaker.com/rainbow-love
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Step 1: Tap
Text, type in
script text,
change your
letter spacing

so the letters E

overlap a bit
(see page
90), select
all, then tap
Actions >
Weld.

CRICUT® COACH PLAYBOOK

HOW TO WELD TEXT
AND KEEP LETTER CENTERS

Welding text can be a little tricky. Typically, you weld script fonts (which can have overlapping letters) so
words cut out as single units. Sometimes when you weld, the centers fill in—here’s how to fix that:

Step 2: If you
get a center

filling in (like

the p here),
tap Undo,
then use
the Resize
handle to
make your
M text MUCH
@)z e@rreoc:e larger, then
S tap Actions >
Weld again.

Step 3: Repeat step 2 until you
can weld and the letter center
does not fill in (you may have
to get REALLY big), then resize
back down to the right size.

Another thing that can happen with text is that letter centers (the interior white space) can disappear
when you cut them out. But you can connect the spaces and keep the centers! Here’s how to fix that:

Step 1: Tap
Text, type
text, and
look for
letters &
numbers
with interior
white space
(counters),
like A, B, D,
O’ P’ Q: R’ a,
o,d, e, g0,
p,qandO0, 4,
6, 8, and 9.

Step 4: Select
the word and
the rectangle,
then tap
Actions >
Slice.

_ Step 2: Tap

Shapes,
select a
square, and
unlock it
and resize it
so it forms
a rectangle
about the
width of
the letter’s
strokes.

Delete all
layers except
the layer
with the
word in it.

_ Step 3: Tap

and drag the
rectangle
over a

letter with
interior white |§
space so it’s
connecting
the space
inside to
the space
outside, like
this:

Repeat steps
2-5 for

all letters as
needed.

|

Practice this at https://jennifermaker.com/script-text and https://jennifermaker.com/adore-text
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CRICUT® COACH PLAYBOOK

HOW TO
KNOCKOUT TEXT

Knockouts are a popular decorative effect. It’s not currently possible to do them completely within
Design Space, but here is a workaround until the day that (hopefully) this feature is added:

Step 1: Tap Step2:Tap R Jstep3ivep |

Text, type ‘ ' Text again, the accent

your main ‘ type an BE AUTlFUL lraelgfi'-‘z"eair;dto BEAUT'FUI.

word in a accent word

bold chunky
font like
Cricut Sans
Bold. Unlock
it, resize it
to make it
taller, and
tap Actions >
Weld.

Step 4: Go to
the Gallery
app on your
Android,
open the
screen shot,
tap the Pencil
icon, crop it
so only the
knockout
word
remains, then
tap Save.

Step 7:

Tap the
background of
the knockout
image to make
it transparent,
then tap Next.

in script font be about =

(i.e., | Love
Glitter).

Adjust letters

as needed,
unlock it,

resize it, and .

tap Actions >
Weld.

Step 5:
Return to
the Cricut
app, tap
the Upload
icon, and
tap Select
from Photo
Library.

Step 8: Tap
Save as cut
image, type
in a name,
and tap Save.

Q@ | e

1[2]s

afwle] ]

lines linewp  lineups
alsfef7]a]o]o fou

o] L e

BAEGRGG DN

half the size
it was, then

take a screen §

shot (hold
down the
Power and
Volume Up
buttons).

Step 6: Tap
the magic
wand icon
labeled
Remove.

#
Remove

Step 9: Insert
the knockout,
resize it to
match your
accent word,
unhide your
main word,
position the
knockout over
your main
word, select
both layers,
and tap
Actions > Slice.

Step 10: Delete the three sliced layers (leaving the
main word layer), tap and drag the accent word inside
the empty space sliced out of the main word, with the
accent word selected tap Edit > Fill menu and change
it to No Fill, tap the color box to change the accent
word color if desired, and tap Make It!

EALITIELI
VRNVl Vi

Practice this at https://jennifermaker.com/beautiful-knockout

KNOCKOUT TEXT (Android)
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CRICUT® COACH PLAYBOOK

HOW TO CHANGE THE
FONT FOR EXISTING TEXT

Step 1: Open Step 2: Tap the
your project and ! font menu in the
double-tap the : lower left corner
text you want to ! i | to view the font
change the font i SEEEEEAERSERRST list.

for.

CHANGE FONT

Step 3: Scroll
through the list
and tap the new
font you want to
use.

CuttinUp-Cartoon

CCatintp- Holuwjﬁ

Cutti‘n Up Serifs

cuttinUp-H.. » R =
P

e
BpEaemnb

n o
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CRICUT® COACH PLAYBOOK

HOW TO
CHANGE COLORS

Step 1: Select ~ & s Step 2: Tap Edit
(tap) the layer . o g g g ol then tap the
you want to ‘ circle above the
change, like the [ “ Linetype option.
center of this

flower.

Step 3: Select Your object
(tap) the color changes to
you want. If the color you
you don’t see selected!
the color you

want, you can

choose any

custom color in

the color picker

below it. When

done, tap the

checkmark.

%)
(24
o
=
o
o
L
)
=z
<
I
O

Note that you cannot set pattern fills in the Android version of Cricut Design Space. If you need to set
pattern fills, use a desktop or laptop to access Cricut Design Space and see directions on page 21.

PAGE 94 </ COPYRIGHT JENNIFERMAKER®




CRICUT® COACH PLAYBOOK

HOW TO CHANGE
LINETYPE AND TOOLS

The Linetype menu lets you change the tool for a layer. Choices for the Joy are Cut (default) and Draw. The
Cricut Explores add Score. The Cricut Makers add Engrave, Deboss, Wave, and Perf. You will only see the
Maker linetype choices if you’ve set your machine to Maker or Maker 3. (Note: You cannot use the Knife or

Foil Transfer tools from Android devices.) Here’s how to set your machine and change the linetype.

Step 1:
Tap the
circle
menu in
the upper
left, tap
Machine
Selection,
then

tap your
Cricut.

Tap Draw
then v/

to set a
layer to
write with
pens and
markers.
You can
choose
the color
and
thickness,
too.

Tap
Deboss
then v to
set a layer
to use the
Debossing
Tool
(Maker
only).

Step 2:
Tap a
layer,
then tap
Edit,
then tap
Linetype.

Tap Score
then Apply
to set a layer
score with
the Stylus
(Maker or
Explore)

or Scoring
Wheel Tools
(Maker only).

oL

Tap Wave
then v to
set a layer to
use the Wavy
Edge Tool
(Maker only).

Tap Cut then
v to use the
fine point,

deep cut, EEEEE
fabric, or EEEEE B

rotary (Maker EEEEE B
only) blades. 1

You cannot
use the knife
blade with
the Android
version of

Tap Engrave
then v to
set a layer
to use the
Engraving
Tool (Maker
only).

Tap Perf
then v to
set a layer
to use the
Perforation
Blade Tool
(Maker
only).

Practice this at https://jennifermaker.com/starry-star
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CRICUT® COACH PLAYBOOK

HOW TO SET TEXT TO
WRITE WITH A PEN

You can insert a Cricut pen or marker into any Cricut Joy, Explore, or Maker machine and have it draw
for you! Many crafters like to use this feature with a writing font to mimic handwriting. Here’s how to
choose a good font that looks like handwriting and set it to Draw in Cricut Design Space:

Step 1: Tap Wit on! Step 2: Wit Ont Step 3: Wite Ont*
Tevt, tap the | preeeeenmmmml Sclect: | mmmrmmmmmmml o 0 | EEEEm
Filter icon, | writing tap Style,
and scroll font i then tap
down to tap T (such as ftere Clon e Writing to
Writing to ll the free # select the
see writing SUseareh Fonts Cricut — Writing |
fonts. Cricut Sans d Sans or b l style of Regulr
Cricut Strefch | Cricut ' the font. old

Type

OifSN Alphabet). —

Some may e
have a WutiLayer
fee’ I-ike Has Writing Style

)

1 v
e mno WU Hrgensle

Image et Shapes Upload Actions
bes  Upload  Actons Make t £e HER

1121 AM 7 Q0 25%(05 ) ol ATET B 11:57 AM 7 Q8 38%(EH )

Step 4: Tap y Wite Ont * Step 5: Cancel Linetype Apply Step 6:
Linetype. gpmmmmmemmen]  Select Adjust the
| Draw and Font Size [
tap apen and Letter |
type and Space as
color. necessary
so it looks
cor the way

n,sta. you want

it to look,

B cocwsPin then click
P Make It.

i € 2 pbraw O

~ Alignmer ize Letter Space Line Spacel  Linetype B Adove
B @ b1 N

ma Shapes  Upload Actions  Edit  § Makelt B ornge Peel

ol ATET B 11:58 AM

&) Mt 1 0f 1 a» Step 8: Insert the pen in your Cricut’s accessory
clamp, position your material on the cutting mat,
load your mat, and press the flashing button.

See my blog post at

https://jennifermaker.

com/cricut-writing for
more tips on writing

on your Cricut! | also

have a free writing font

you can use at https://
o jennifermaker.com/

L agi= e writing-font

WRITE WITH A PEN

Practice this at https://jennifermaker.com/write-on
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CRICUT® COACH PLAYBOOK

HOW TO SCORE WITH
STYLUS

Step 1: Open or
create a project
with score lines.
You can add a score
line to any project
by tapping Shapes,
then tapping Line.

Step 3: Make sure
the score line is on
the same layer as
the cut, then tap
Continue.

Step 5:

Tap on the
scoring
tool of
preference,
then tap
Continue.

S OR WHEEL

Step 2: Make sure any
lines you want to be
scored are attached to
the layer that should
have the score line (tap
the arrow on the layer
to change). Tap Make It.

Step 4: Check the
necessary tools. If the
screen says to use a
scoring wheel but you do
not have one, tap Edit
Tools.

(), Viaterial set : Medium Cardstock - 80 Ib
cure et

© Load Nygs & Mat

\ Before cur gt sureyou

Step. 6: Insert the gﬁmge

scoring tool that

matches step 5, m'é'i“
then click the

flashing icon on
your Cricut.

Practice this at https://jennifermaker.com/love-card
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Step 1: Open or
create a project.
Make anything
you want to
appear on the
same mat the
same color. Tap
Make It.

Step 3: Move
each object

on the mat by
tapping and
dragging to a new
position. You can
also rotate.

CRICUT® COACH PLAYBOOK

HOW TO REPOSITION
ITEMS ON MAT PREVIEW

09:00 PM

Step 2: Make - Mat 1of1
sure the items

you want to
reposition are
all on the same
mat.

Z 5 © © N o o & o N -

m the placement

3 7 93%M9:01 PM

Step 4: Make
sure the material
on your actual
mat matches

Mat 10f1 Mat 10f 1

on this virtual
mat, then tap
Continue.

Practice this at https://jennifermaker.com/butterflies
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CRICUT® COACH PLAYBOOK

HOW TO MIRROR AND
CUT IRON ON VINYL

Want to make a T-shirt or bag with iron-on vinyl? Here’s how to mirror your image and position your vinyl
on your mat for iron-on (heat transfer) vinyl!

Step 1:
Select all
the objects
you want
to iron-on,

tap Actions,

then tap
Attach.

Step 4:
Toggle
Mirror to
the on
position
and tap on
the gray
area to
close this
panel.

Step 7:
Search

for “iron”
and select
the type

of iron-on
vinyl you
plan to use.

Step 5:
Verify that
your image

is mirrored, }}

then tap
Continue.

Step 8:
Place
your iron-
on vinyl
on your
cutting
mat shiny
side
down,
insert the
mat, and
press Go.

(D) Waterial set ; Everyday Iron-On

Step 3:
Tap the
mat icon
in the
upper
left
corner
of the
screen.

Step 6:
Tap on All
Materials.

Remember, put the vinyl
SHINY SIDE DOWN on your
cutting mat!

|

MIRROR / IRON-ON VINYL

Practice this at https://jennifermaker.com/simple-smile
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CRICUT® COACH PLAYBOOK

HOW TO SAVE WORK
AND VIEW SAVED PROJECTS

Step 1: PN  Step 2: Give the
Create i project a name and
something i tape Save.

and tap the

Save icon.

You can tell when a

project is unsaved

when the title area is

blank.

Step 3: ine your If Cricut is able to
device t'lme to save save your project, a
the project. Make sure confirmation notice

you are near your will appear at the
Wi-Fi source for the bottom.

Pentagon! s

best results.
Save Successful Diamond

& TR Y% $S A

s Upload Actions Syc  Layers  Undo

SAVE WORK/PROJECTS

3 T 98%M5:31 PM

To view your Saved @
Projects, tap the Home
link at the top, then tap My ey o ke Projects LY
the All Categories menu Festred Projcs VE
and choose My Projects. Al tegoris

& Cricut Access
Note that you cannot :
currently share a project Aona e '
from the Android version =
of Cricut Design Space, but
you can save a project on e ' '@
Android and then access C'h: et
and share it from the e

Free for Cricut Explore Air

desktop version. Fee oGt e A2 D) R

Heart Slice

Free for Cricut Explore One 5
)
Free for Cricut Maker
Rose Arbor Luminary by
Graduation
[Tresman

Haliday o e,

Practice this at htt s://jennifermaker.com/love-decal
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CRICUT® COACH PLAYBOOK

HOW TO
FLATTEN

Step 1: Add two or more items
to your canvas that you want to
flatten.

Step 2: Tap and drag a selection
box around all objects you want to
flatten to select all of them.

then tap Flatten.

Step 3: Tap Actions, LEI

Actions
Note that all items

are now on one layer and now
work only for Print Then Cut.

FLATTEN

If you decide this isn’t
what you wanted to do,
tap the Unflatten button
right away.

Practice this at https://jennifermaker.com/five-hearts
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CRICUT® COACH PLAYBOOK

HOW TO
UPLOAD IMAGES

Step 3:
Tap Select from Photo Step 4: :
Library to locate an Tap the image file, such

Tap New Project Tap Upload e saved there.

Tailgate Toddler T-s

Upload Image

Take ol

Select from Photo Library

openop

Step 6: Step 7:
Look at the box in the Clean it up (if Name your image Tap the uploaded
upper left corner — you want) and and tap Save. image and then
that is the cut file. tap Next. tap Insert.

Heart Heartland

I DEEREDORRDE
{ el

elrltlylulilolp @

Practice this at https://jennifermaker.com/rainbow-heart
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CRICUT® COACH PLAYBOOK

HOW TO ERASE A
BACKG

Step 1: Find or X Cleanup Step 2: Tap the
upload a JPG, Remove tool .
PNG, GIF, or BMP -

file that you want

to use. Tip: You'll
need to save

to your Photos
library in order
to upload it. Use
Google Drive or
something similar

to transfer files if
necessary.

ERASE BACKGROUND

Clean up image using the tools below.

Y- -
—

Step 3: Tap T : e > Step 4: Check the JR——
on the white . cut lines of the

background object. If you need
around your to fix it, tap the back
image to erase it. arrow. If it looks
You may need to good, give it a name
click in several and tap Save.

areas to get it all.

The slider at the

bottom controls

how much of a

given color you

remove. When it

qg w e r t y u
looks good, tap ’ Ia[s[d[dg[n]
=

eart
6

4 4/ 7%

Next. z clvlbln

sym 5 English(US)

Step 5: Once
saved, you can
use the image by
selecting it and
clicking Insert
Image.
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Step 1:
Open the
project
you want
to add to
another
and turn
off the grid
by tapping
Settings
and toggle
the Grid
off.

Step 4:
Open the
project

to which
you want
to add
your other
project.
Allow it
to replace
your
current
canvas.

Step 7: Tap
the first
project’s
image, tap
Actions,
tap
Duplicate,
and make
as many
duplicates
as there
are
elements
in the
project.

CRICUT® COACH PLAYBOOK

Practice this at

https://jennifermaker.com/butterflies and

HOW TO

Step 2:

If any
individual
elements
in your
design are
touching
and you
need them
separated,
move
them
apart now.

Step 5:
Follow
previous
pages to
upload the
image from
step 3 and
remove
the back-
ground. Tap
Cut Image
then tap
Save.

) butterflies butterflied butter flies butterflys
1f2]sfals[es]7]s]o]o foe
aoononnonnnc

AEGGEGOOR T

Step 8:
Select
each
duplicate
copy
and tap
Actions >
Hide (see
Contours
on page
53) to
separate
out each
element
into its
own layer.

COMBINE MULTIPLE PROJECTS

Step 3: Take a picture of
Design Space screen by
pressing the Power button and
the Volume up button at the
same time. Quickly release
both buttons. Go to Home
screen and tap Gallery, find
the image,

tap the

Pencil icon,

and crop w "
it (slide in L
the sides)

to just the

design, and

tap Save.

Step 6:
Insert the
newly
uploaded
image
onto your
Canvas
with the
other
image
from step
4,

Step 9:
Recolor
each
element
(see page
21) as
needed
and move
back into
position.
Now
your two
projects
are
combined!

https://jennifermaker.com/rainbow-love
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CRICUT® COACH PLAYBOOK

HOW TO UPLOAD SVG FILES
ON AN ANDROID

SVG files are special files that you can upload to Cricut Design Space and cut beautiful designs from.
To use an SVG, first you must download and unzip an SVG file. You can practice downloading a file at
jennifermaker.com/svg-heart. To unzip a file, go to My Files on your Android, tap on Downloads, tap to
select the downloaded ZIP file, click on the three dots in the upper right corner of your screen, and
choose Extract. Note that you will not see the folder in step 4 unless you do this first.

Step 1: Step 2: @ Step 3: Tap Select Step 4: Tap the B menu
Tap New Project Tap Upload (e from Photo Library and open Downloads

534@% 6 . CEN

= Downloads Q i

MAGES O DOWNLOA0S.
cricut-kickoff-certificate jennifermaker (1)
cricut-kickoff-certificate-jennifermaker
Tea-Bag-Card-JenniferMaker
owl-shadow-card-jennifermaker.svg
owl-shadow-box-card-jennifermaker (1)

‘owl-shadow-box-card-jennifermaker

Design to Shine Toolb

prasrowme Toousox
L LLY (X 28
-

Step 5: Step 6:

Tap the SVG file (do Enter a name for your Tap the uploaded
NOT tap the ZIP file—it image, then tap Save. SVG and then tap
will give you an error). Insert.

=
(@]
&
a
4
<
v
O
>
w
a
<
(@]
|
o
=

€ Prepare to Upload

Upload Ty
Each colo i

Practice this at https://jennifermaker.com/svg-heart
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HOW TO
RESIZE A PROJECT

Have you ever uploaded an SVG design, cut it out, and realized it was too small or too big? Here’s how to
check the size of a project before you cut it out:

Step 1: Insert, e Step 2: Tap Edit,
upload, or create - : ’ g z i then note the size
an image on your at the bottom of the
canvas in Design : window in the Width
Space, then and Height circles.
select all images
you want to
resize by tapping ]
and dragging a 10567 — @ — 4.447
selection box
around them.

Width Height

To determine if the sizing is right, compare it to the sizing in the original instructions or tutorial. If no sizing
is provided, you’ll have to use your best judgment. Here’s how to resize a project:

Step 3: Be sure
the lock icon
indicates it is
locked, then
tap the Width

or Height circles
and tap on the
number pad to .
enter the proper o1 1® BRI
size, then tap - NG 5 — & 2104
Done. s

Width Height

RESIZE A PROJECT

locked Note that Cricut Design

resize any SVG file that

measures over 23.5"

(either wide or high)

down to 23.5” on its longest side, and there is no

You can also resize images using the resize icon notification that an image was resized. So if you ever
in the lower right corner of a selection box. place an image on your canvas and notice that one
Just click, hold, and drag to resize. side measures exactly 23.5”, that is a strong indicator
that your image has been resized.

Practice this at https://jennifermaker.com/butterflies
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HOW TO UPDATE THE
CRICUT APP ON ANDROID

Step 1: Open your Cricut Design
Space app. If a new version is

available, it will tell you. Tap Update.

Cricut Design Space
Cricut
In-app purchases

— -

What's new ¢ >
Last updated May 5, 2021

Bug fixes and improvements

Rate this app
Tell others what you think

w w w 1A

Write a review

Developer contact

Join the beta

Try new features before they're officially released and give
your feedback to the developer.

Join  Learn more

Step 2: Tap Update. Make sure you
have a good Internet signal for the
best results.

Cricut Design Space
Cricut
In-app purchases

What's new «
Last updated May 5, 2021

Bug fixes and improvements

Rate this app
Tell others what you think

hAe w ¥ ¢

Write a review

Developer contact

Join the beta

Try new features before they're officially released and give
your feedback to the developer.

Join  Learn more

Alternatively, you can go to the

Home screen and tap the Play
Store to check for updates.

il
0 @ Updated /! 439PMCD

Galaxy Store. Chrome
CEE

Clock cut Design

Step 3: Wait for the Cricut
Design Space app to update,
usually just a few minutes.

Cancel

What's new =
Lastupdated May 5, 2021

Bug fixes and improvements

Rate this app
Tell others what you think

¥ A A A

Write a review

Developer contact

Join the beta

Try new features before they're officially released and give
your feedback to the developer.

Join  Learn more

Once in the Play Store, tap
the Search bar and search
on Cricut Design Space.

cricut design space app
cricut design space app for chromebook
cricut design space app for android
cricut design space app update

cricut design space app free

spaces spaced sspaceship spacers

English (US)

©

Step 4: Tap Open to launch
the updated version of the
Cricut Design Space app.

Cricut Design Space
Cricut
In-app purchases

What's new 5
Last updated May 5, 2021

Bug fixes and improvements

Rate this app
Tell others what you think

A A w ¥

Write a review

Developer contact

Join the beta

Try new features before they're officially released and give
your feedback to the developer.

Join  Learn more

PAGE 107 ¥V COPYRIGHT JENNIFERMAKER®

UPDATE CRICUT APP




CRICUT® COACH PLAYBOOK

HOW TO TROUBLESHOOT

DESIGN SPACE PROBLEMS

Your ability and willingness to troubleshoot problems is a high factor in your success with your Cricut (and
really, most things in life). Problems happen, but you CAN solve them. Here are the steps | take when |

encounter problems with Cricut Design Space:

Cricut Design Space is acting weird or not working at all.

Is it down? Check status.cricut.com

Watch the status site for it to come back. Yes No

Still having problems? Is it installed and up-to-date?

Yes Restart your device. Yes No

No
Are you still having problems?

Do you have a strong Internet connection? Yes No

Keep the app with Design Yes No
Space open and don’t
move away while cutting.

Connect to Internet &
move your Cricut and
device closer to router.

Are you still having problems? Still having problems?

Close any other apps running on your

. Yes No
device.

Yes No
Are you still having problems?

Make sure your Cricut is actually

connected via Bluetooth. V3 Mo

Are you still having problems?

Disconnect your Cricut, restart your

. . Yes No
device, and reconnect your Cricut.

Are you still having problems?

Yes No

Having different problems?
Here are more solutions:

Machine problems:
Check the Cricut site at
https://help.cricut.com

Cutting problems:

Check my ideas at
https://jennifermaker.com/
cutting-problems

Mat problems:
Check my mat tips at
https://jennifermaker.com/

mat-tips

Blade problems:
Check my blade tips at
https://jennifermaker.com/

blade-tips

Contact Cricut Member Care. | recommend the Chat option when it’s available (check here), otherwise
you can call during open hours or email them at anytime. Cricut Member Care is very helpful!

Android

TROUBLESHOOTING


http://status.cricut.com
https://jennifermaker.com/cricut-member-care
https://jennifermaker.com/cricut-member-care
https://help.cricut.com
https://jennifermaker.com/cutting-problems
https://jennifermaker.com/cutting-problems
https://jennifermaker.com/mat-tips
https://jennifermaker.com/mat-tips
https://jennifermaker.com/blade-tips 
https://jennifermaker.com/blade-tips 

CRICUT® COACH PLAYBOOK

While | generally recommend you use this playbook electronically on your
computer or mobile device to save paper, search easier, and keep the latest
version, | know that some people prefer to have a printed hard copy. So here
are some tips on printing this Playbook:

Download the book, open the PDF from within Adobe Reader, and print from inside Adobe
Reader for the most options, flexibility, and quality. You can get Adobe Reader free at
https://get.adobe.com/reader

Whenever possible, print from a desktop or laptop computer—iOS devices have known print
bugs that can cause images to disappear.

Always do a test print before you print all the pages to ensure you have ink in your printer,
that the quality is good enough for you, and so on.

Before you send the entire playbook to print, look through it and decide if you really want
all the pages to be printed. There are sections on desktop, i0S, and Android, and you may

not need all of them. Pages to Print

You can print specific pages (say, just iOS pages, or just updated i
pages) by typing just the page numbers in your Print dialog box, Current page
like this: @ Pages || 5-15, 22, 30-34

If you’re concerned about ink usage, you can print in grayscale instead (look for an option
in your Print dialog box for grayscale or black and white). Another option is to click on your
Printer settings and change your quality to “draft” and this will save more ink (but do a test
first, as you may not like it).

If your test print looks blurry, click on your Printer settings and make sure your quality
settings are set to normal or even best for the highest resolution print.

Readers outside the U.S. may need to print on A4 paper. If you do this, make sure your pages
are not being reformatted before you print them (check the print preview box). You can also
scale your pages down 97% to print on A4.

If you intend to keep your playbook updated with future updates, put the pages in clear
protective sleeves in a binder rather than have the pages bound—it’ll be easier to add and
update pages that way.

If you do not have a printer or would rather someone else print it, you can send your PDF to

a copy shop or an office supply store like Staples.com. You can also tell them that you want
only certain pages printed, too!
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To Whom It May Concern:

The bearer of this notice (“Bearer”) has purchased a digital download from
JenniferMaker.

YOU, the PRINT/COPY SHOP, are hereby granted permission to make an
unlimited number of prints as long as it is reasonably obvious to you that my
customer is having these printed for their own personal use.

CUSTOMER agrees that you may not use any of these files for commercial or
editorial purposes without the express written permission of JenniferMaker.
com. JenniferMaker LLC retains the copyright to all digital files,per USC

Title 17 (US Copyright Law). The digital files that are being provided to you

are licensed to you for any reasonable personal purposes, including but not
limited to: printing, copying, and emailing. Your license does not include use
that results in financial gain, including but not limited to: advertising, stock
photography, or resale of any nature. Your purchase of the original files releases
JenniferMaker LLC from any liability due to loss or damage of the files, and also
releases us from any obligation to maintain copies of any digital file, image,

or photograph. JenniferMaker LLC may revoke this license at any time and for
any reason. JenniferMaker LLC retains all copyrights to the files and derivative
works thereof.

By using any of these files, you are agreeing to the above terms.

\ps

Jennifer Marx
JenniferMaker® LLC
hello@jennifermaker.com

Cricut® Coach Playbook is copyright 2018-2021 by JenniferMaker® LLC. All rights reserved. Cricut® and Cricut Design Space®
are registered trademarks of Provo Craft. Use of them does not imply any affiliation with or endorsement by them.
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NEED TO WATCH EVERYTHING
IN ACTION?

If you’ve ever wished you could SEE me do each of the tasks in Cricut
Coach Playbook in a VIDEO, then you’re going to love the ...

This “play-by-play” library of videos shows how to do all the important tasks in
Cricut Design Space on Desktop, i0S, and Android.

Each video is just a few minutes long so when you need help with Slice or Print Then Cut,
you just watch the video then apply what you learned immediately, so you can get right
back to making things!

No more endless searching on YouTube or through posts to find a simple answer.

| show you exactly what to do, where to click, and how to make it work!

And the entire collection is searchable, captioned, transcripted, and downloadable, too!

Get my Cricut Play-by-Play Videos at
https://jennifermaker.com/cricut-play-by-plays
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READY TO DIG DEEPER INTO
CRICUT DESIGN SPACE?

Introducing...

DESIGN TO SHINE is a FUN, project-based Cricut Design Space course that
builds upon itself logically in each unit, walking you through every important
task, step by step. Each thing | teach is explained clearly in searchable videos

and printable workbooks, and then reinforced over and over in a variety of
ways to make sure you learn in the way that works best for you. | don’t skip
steps — | take you through slowly, explaining everything as | go.

In DESIGN TO SHINE, you are fully supported through our Q&A Center, Play-by-Play videos,
Behind the Design videos, and our private Student Group. And you can watch and re-watch
whenever and wherever. And | help everyone, regardless of whether you are on Design
Space for Desktop, i0S, or Android, so even if you have Desktop right now, when you get
that brand new iPad next year, you can revisit Design to Shine and learn how to use Design
Space in i0S, too! This is a true program, one built carefully and thoughtfully to really
teach you how to independently make projects on your own without relying on expensive
SVGs or following step-by-step tutorials for the rest of your crafting life.

Learn more at:
https://jennifermaker.com/design-to-shine
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WANT TO MAKE YOUR OWN
CRICUT DESIGNS TO SHARE OR SELL?

Do you spend too much time searching for just the right design
or cut file for your project?
Do you have to compromise on what you want just to make something.
Or, worse yet, do you refuse to settle and never finish that project?

What if, instead, you could design whatever you wanted,
whenever you wanted?

Imagine how it will feel to finally make precisely what you envision, just the way you want,
without compromise. Imagine having the know-how to impress everyone, even yourself,
with what you can create. Imagine being connected to others who are on the
same journey as you... all committed to designing beautiful things that they can upload,
share with others, and even sell.

| cracked the code on creating SVG cut files to make gorgeous projects that have been
shared over a million times. My files even got the attention of a book publisher, who just

two months after | learned to do this, offered me a book deal. My crafting projects, my
blog, and my entire life, have been forever changed by my ability to design SVG cut files.

IMAGINE WHAT IT COULD DO FOR YOU?

| can show you how to create SVG files that work with minimal fuss and bother, allowing
you to create beautiful and cuttable designs on a whim. Use your designs for your personal
projects, share them with friends and family, or even sell them to earn extra money!

JENNIFERMAKER

LEARN TO CREATE SVG CUT FILES
TO UPLOAD, SHARE. OR SELL

by
Get on the waiting list for enrollment at
https://jennifermaker.com/cut-above
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CRAFT A LIFE YOU LOVE

Visit me at https://JenniferMaker.com regularly
for inspiration, help, and projects!

v
JENNIFERMAKER

DESIGNER DIY CRAFTS

C/wﬁa/()‘b@mgeu lore

HOME ABOUT PAPER CRAFTS VINYL CRAFTS DECOR BLOGS LIBRARIES ACADEMY
ULTIMATE GUIDE TO THE HOW TO MAKE MUST-HAVE YowTe v
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LOOKING FOR SOMETHING?

MAKE AN EASY a

- ,i\ P " ‘ | 4-;‘.-.5 I ‘T";‘
E&y ,ﬁ:‘ H;fﬁ E W}’ WELCOME!
1 Fuai L N

| inspire you to make crafts and

decorate your home. I'm always
working on something new and
fun! Follow along on my DIY
adventures, reconnect with your
creativity
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